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Chapter1: About this Help Text 
 

 

 Scope and Audience 

  About the Performance Intelligence Center 

  Customer Care Center 

 PIC Documentation Library 

 Locate Product Documentation on the Customer Support Site 
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Scope and Audience 

 
This User’s Guide provides information about ProTrace concepts. It is designed to be a general 

guide to working with ProTrace. Beginners and experienced users alike should find the 

information they need to cover all important administration activities required to use and manage 

ProTrace. Depending on your user access role, some functions in this guide may not be available. 

Only users with BusinessManager role can see PDUs and their decoding. 

About the Performance Intelligence Center 
 

The Performance Intelligence Center (PIC) is a monitoring and data gathering system that 

provides network performance, service quality and customer experience - across various 

networks, technologies, protocols, etc. Beyond monitoring performance and gathering data, the 

solution also provides analytics, actionable intelligence and potentially an intelligent feedback 

mechanism. It allows Service Providers to simultaneously look across the Data Link, Network, 

Transport and Application layer traffic to better correlate and identify the impact of network 

problems on revenue generating applications and services. PIC functionality is based on the 

following general flow. The Integrated Message Feeder (IMF) is used to capture SS7 and SigTran 

traffic. The Probed Message Feeder (PMF) is used to capture both SS7 and IP traffic. Both 

products forward Probe Data Units (PDUs) to the integrated xDR Platform (IXP). The IXP stores 

this traffic data and correlates the data into detailed records (CDRs, IPDRs, TDRs, etc.). The IXP 

then stores the data on the system for future analysis. The Network Software Platform (NSP) 

provides applications that mine the detailed records to provide value-added services such as 

network performance analysis, call tracing and reporting. 

PIC centralized configuration tasks fall into one of two categories: 

 
 Data Acquisition and Processing – the configuration of the probes, routing of PDUs to the 

xDR 

o builder setup, KPI generation, data feeds, etc. 

 PIC System Administration - the configuration of monitoring sites, configuring PIC servers, 

setting up permissions, etc. 

Note:  For more information see Centralized Configuration Manager Administration Guide. 

This is a graphic overview of the PIC system. 
 

 
 



12 

 
 

Figure 1: PIC Overview 

User Preferences 

All applications that query xDRs use a specific User Preferences option. The description outlined 

goes over the formatting screens.  

Note:  All screen shots presented here show default values. 

 Date/Time Tab Screen 

               Format the time parameters. 

 

 

 

 

 

Figure 2: Date/Time Tab Screen 

 
 
 

 

Table 1: Time Tab 



13 

 
Field 

 
Description 
 

 
Date Format 

 

 
Required field - Sets date format. 
 

 
Time Format 
 

 
Required field - Sets time format. 
 

 
Date and time fields 
 

 
Required field - Sets the date and time format. 
 

 
Duration fields 
 

 
Sets a duration format 

 
Time Zone 
 

 
Pull-down list for selecting the desired time zone 
 

 
Reset Button 
 

 
Resets all the tabs to default values 

 
Reset Tab Button 
 

 
Resets to default values for the specific tab. 
 

 
 
Apply Button 
 

 
 
Applies any changes to the system. 
 
 
 

 
Cancel Button 
 

 
Exits the screen 

Directory Tab 

 

Select the Directory tab to set the defaults directories used in transport screen.  
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Figure 3: Directory Tab Screen 

Table 2: Directory Tab 

 
Field 

 
Description 
 

 
Export Directory 

 

 
Enables you to set the default directory for exporting. 
 

 
Upload Directory 
 

 
Enables you to set the default directory for uploads  

 
Download Directory 
 

 
Enables you to set the default directory for downloads  

 
Reset Button 
 

 
Resets all the tabs to default values 

 
Reset Tab Button 
 

 
Resets to default values for the specific tab. 
 

 
Apply Button 
 

 
Applies any changes to the system. 
 

 
Cancel Button 
 

 
Exits the screen. 
 

 
Note:  The directories must be present on the NSP server side. See warning at the bottom of the 

Directory tab screen. 

 
 

Mapping tab 

Select the Mapping tab to set the xDR display parameters. 
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Figure 4: Mapping Tab Screen 

Table 3: Mapping Tab 

 
 
Field 

 
Description 
 

 
Translate ENUM values 

 

 
Selects whether ENUM values are translated or not Default is to select ENUM 

values translation. 
 

 
Point Code to Node 

Name 
 

 
Select this if you want to use the Node Name instead of the Point Code 

name in the xDR display. Default is to use Node Name. 
 

 
Link Short Name to Long 
Name 
 

 
Selects whether you can use long name (Eagle) for link sets .Default to use 
Long Name  

 
Reset Button 

 

 
Resets all the tabs to default values. 
 

 
Reset Tab Button 

 

 
Resets to default values for the specific tab. 
 

 
Apply Button 

 

 
Applies any changes to the system. 
 

 
Cancel Button 

 

 
Exits the screen. 
 

 
 

Point Code tab 

Select the Point Code tab, shown and described in the figure and table. 
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Figure 5: Point Code Tab 

Note: if Session Point Code feature is enabled the Point Code tab will look like 

 

Figure 6: Point Code Tab with Session Point Code Enabled



 

Table 4: Point code Tab 

Field 
 
 

 
Description 

 
Hexadecimal display 
 

 
European defaults are hexadecimal and display with Group 0-3, 

Group 1-8, Group 2-3, Group 3-0. 
 

 
Decimal display 
 

 

North American defaults are decimal and display with Group 0-7 and 
Group 1-5. 

 
Split format 
 

 
Select or deselect Spilt format. 

 
Separation 
 

 
Select a Bit Group Separation 

 
Group 0 
 

 
Type a value. (0-7 or 1-5 see hexadecimal or decimal display) 

 
Group 1 
 

 
Type a value. (0-7 or 1-5 see hexadecimal or decimal display 

 
Group 2 
 

 
Type a value. (0-7 or 1-5 see hexadecimal or decimal display) 
 

 
Group 3 
 

 
Type a value. (0-7 or 1-5 see hexadecimal or decimal display) 
 

 
Reset Button 
 

 
Resets all the tabs to default values. 
 

 
Reset Tab Button 

 

 
Resets to default values for the specific tab. 
 

 
Apply Button 

 

 
Applies any changes to the system 

 
Cancel Button 

 

 
Exits the screen. 
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CIC tab 

 
Select the CIC tab to set the parameters for CIC and Bit groups. 

 
Figure 7: Formatting Rules (CIC) Screen 

Table 5: CIC Tab Field Descriptions 

Field 
 
 

 
Description 

 
Hexadecimal display 
 

 
European defaults are hexadecimal and display with Group 0-3, 

Group 1-8, Group 2-3, Group 3-0. 

 
 
Decimal display 
 

 

North American defaults are decimal and display with Group 0-7 and 
Group 

1-5. 
 

Split format 
 

 
Select or deselect Spilt format. 

 
Separation 
 

 
Select a Bit Group Separation Group 0:8, Group 1:8. 

 
Group 0 
 

 
Type a value. (0-7 or 1-5 see hexadecimal or decimal display) 

 
Group 1 
 

 
Type a value. (0-7 or 1-5 see hexadecimal or decimal display 

 
Reset Button 
 

 
Resets all the tabs to default values. 
 

 
Reset Tab Button 
 

 
Resets to default values for the specific tab. 
 

 
Apply Button 

 
Applies any changes to the system 
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Cancel Button 
 

 
Exits the screen. 
 

 

 Default Period tab 
 
Select the Default Period tab, for setting the default time period for beginning and ending time for  

traces (ProTrace only). 
 

Figure 8: Default Period Tab Screen (ProTrace only) 

 

 
 

Table 6: Default Period Tab Field Descriptions 

 
 
      Field 
 
 

 
Description 

 
Default Period (in hours) 
 

 
Sets the default run time period for running traces. Default is 24 

hours. Range 1-7200 
 

 
Reset Button 
 

 
Resets all the tabs to default values. 

 
 

Reset Tab Button 
 

 
Resets to default values for the specific tab. 
 

 
Apply Button 
 

 
Applies any changes to the system. 
 

 
Cancel Button 
 

 
Exits the screen. 
 

 
After setting the formatting parameters, click Next to move to the next screen in the wizard. 
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Customer Care Center 

 
The Tekelec Customer Care Center is your initial point of contact for all product support needs. A 
representative takes your call or email, creates a Customer Service Request (CSR) and directs your 
requests to the Tekelec Technical Assistance Center (TAC). Each CSR includes an individual tracking 
number. Together with TAC Engineers, the representative will help you resolve your request. 
 
The Customer Care Center is available 24 hours a day, 7 days a week, 365 days a year, and is linked to 
TAC Engineers around the globe. 
 
Tekelec TAC Engineers are available to provide solutions to your technical questions and issues 7 days a 
week, 24 hours a day. After a CSR is issued, the TAC Engineer determines the classification of the trouble. 
If a critical problem exists, emergency procedures are initiated. If the problem is not critical, normal support 
procedures apply. A primary Technical Engineer is assigned to work on the CSR and provide a solution to the 
problem. The CSR is closed when the problem is resolved. 
 

Tekelec Technical Assistance Centers are located around the globe in the following locations: 
 

Tekelec - Global 
 

Email (All Regions): support@tekelec.com 
 
 

 USA and Canada 
 

Phone: 
 

     1-888-FOR-TKLC or 1-888-367-8552 (toll-free, within continental USA and Canada) 

1-919-460-2150 (outside continental USA and           

Canada)  

TAC Regional Support Office Hours: 
 

8:00 a.m. through 5:00 p.m. (GMT minus 5 hours), Monday through Friday, excluding 
holidays 

 

  Caribbean and Latin America (CALA) 
 

Phone: 

USA access code +1-800-658-5454, then 1-888-FOR-TKLC or 1-888-367-8552 

(toll-free)  

TAC Regional Support Office Hours (except Brazil): 
 

10:00 a.m. through 7:00 p.m. (GMT minus 6 hours), Monday through Friday, excluding 
holidays 

 
 Argentina 

 

Phone: 
 

0-800-555-5246 (toll-free) 
 

 Brazil 
 

Phone: 
 

0-800-891-4341 (toll-free) 
 

TAC Regional Support Office Hours: 
 

8:30 a.m. through 6:30 p.m. (GMT minus 3 hours), Monday through Friday, excluding 
holidays 
 

 

mailto:support@tekelec.com
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    Chile 
 

Phone: 
 

1230-020-555-5468 
 

 Colombia 
 

Phone: 
 

01-800-912-0537 
 

  Dominican Republic 
 

Phone: 
 

1-888-367-8552 
 

  Mexico 
 

Phone: 
 

001-888-367-8552 
 

   Peru 
 

  Phone: 
 

0800-53-087 
 

 

  Puerto Rico 
 

Phone: 
 

1-888-367-8552 (1-888-FOR-TKLC) 

 
 

  Venezuela 
 

 Phone: 
 

   0800-176-6497 

 
 Europe, Middle East, and Africa 

 

Regional Office Hours: 
 

8:30 a.m. through 5:00 p.m. (GMT), Monday through Friday, excluding holidays 
 

 Signaling 
 

Phone: 
 

+44 1784 467 804 (within UK) 
 

 Software Solutions 
 

  Phone: 
     

     +33 3 89 33 54 00 
 

    Asia 
 

 India 
 

Phone: 
 

    +91 124 436 8552 or +91 124 436 8553 
 

TAC Regional Support Office Hours: 
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10:00 a.m. through 7:00 p.m. (GMT plus 5 1/2 hours), Monday through Saturday, 

excluding holidays 
 

 Singapore 
 

  Phone: 
 

    +65 6796 2288 

TAC Regional Support Office Hours: 
 

9:00 a.m. through 6:00 p.m. (GMT plus 8 hours), Monday through Friday, excluding holidays 
 
 

PIC Documentation Library 
 

PIC customer documentation and online help are created whenever significant changes are made 

that affect system operation or configuration. Revised editions of the documentation and online help 

are distributed and installed on the customer system. Consult your NSP Installation Manual for 

details on how to update user documentation. Additionally, a Release Notice is distributed on the 

Tekelec Customer Support site along with each new release of software. A Release Notice lists the 

PRs that have been resolved in the current release and the PRs that are known to exist in the 

current release. Listed is the entire PIC documentation library of user guides. 
 

 Security User Guide 
   Alarms User Guide 
    ProAlarm Viewer User Guide 
    ProAlarm Configuration User Guide 
    Centralized Configuration Manager Administration Guide 
    Customer Care User Guide 
    Alarm Forwarding Administration Guide 
    Diagnostic Utility Administration Guide 
    ProTraq User Guide 
    ProPerf User Guide 
    ProPerf Configuration User Guide 
    System Alarms User Guide 
    ProTrace User Guide 
    Data Feed Export User Guide 
    Audit Viewer Administration Guide 
    ProDiag User Guide 
    SigTran ProDiag User Guide 
    Report Server Platform User Guide 
    Reference Data User Guide 
    Exported Files User Guide 
    Scheduler User Guide 
    Quick Start User Guide 

Locate Product Documentation on the Customer Support Site 

 
Access to Tekelec's Customer Support site is restricted to current Tekelec customers only. This 

section describes how to log into the Tekelec Customer Support site and locate a document. 

Viewing the document requires Adobe Acrobat Reader, which can be downloaded at 

www.adobe.com. 
 

1. Log into the https://secure.tekelec.com/OA_HTML/ibuhpage.jsp  site. 
 

   Note:  If you have not registered for this new site, click the Register Here link. Have your customer 

number available. The response time for registration requests is 24 to 48 hours. 
 

2. Click the Product Support tab. 

https://secure.tekelec.com/OA_HTML/ibuhpage.jsp
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3. Use the Search field to locate a document by its part number, release number, document name, or 
document type. The Search field accepts both full and partial entries. 

4. Click a subject folder to browse through a list of related files. 

5. To download a file to your location, right-click the file name and select Save Target As. 
 
 
 
 
 
 
 
 

  



 

 24 

Chapter 2: Introduction to ProTrace 

 

 
 

 
 

 Introduction to ProTrace 

 Configuring Network Views for ProTrace 

 Opening ProTrace 

 Understanding the ProTrace Interface 

 xDR Viewer Page 
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     Introduction to ProTrace 

 
ProTrace is a near real-time, end-to-end, multi-protocol call tracing application. ProTrace has the 

capability of performing scenario-less traces for in-progress and completed calls, transactions and 

sessions. 

ProTrace traces the calls, transactions and sessions based on xDRs generated by an IXP 

Subsystem. ProTrace can perform an in-progress display of a traced transaction/call/data session. 

The capability to perform the scenario-less inter-protocol tracing is the ProTrace built-in feature 

eliminating the need for defining complex scenarios. This section provides the high level architecture 

of the ProTrace application. 

ProTrace is built on the NSP Platform and uses the various NSP common components such as 

Data Access Layer (DAL) and Centralized Configuration Manager (CCM) for its functionality. The 

data access layer provides the APIs to access the IXP Oracle database (for xDR sessions) through 

user-defined filters. CCM provides the configuration elements such as network view constituents 

(dictionaries, filters, link-sets etc), for the ProTrace application. 

ProTrace operates within a network (sessions) context and enables you to manage (create, modify 

and delete) as well as store queries for a particular network view. 

This figure depicts the overall architecture and interaction of ProTrace with the NSP server. 
 
 

 
            Figure 9:ProTrace Block Diagram 

 
The ProTrace Engine and the ProTrace Viewer components comprise the ProTrace application. The 

ProTrace engine component provides the logic for inter-protocol call tracing. It also provides the 

plug-ins that support inter-protocol tracing. These plug-ins provide the mapping of EPIs for co-

relating protocols. The ProTrace engine supports intra-protocol tracing by utilizing  Transaction 

Identifiers generated by the IXP subsystem as well as partial xDRs (xDRs which are generated 

before the transaction or call is finished). In addition, the ProTrace engine also provides the APIs for 

the ProTrace viewer to initiate various operations such as: XDR filtering, initiating Trace, and 

managing ProTrace Filters. 

The ProTrace viewer component serves as the end-user interface. This enables you to initiate and 

view either single or multiple traces (maximum five). Multiple users (the number of users is based on 

purchased licenses) can connect to ProTrace using a Web interface provided by the NSP platform. 

ProTrace provides the following functionality: 
 

  Real-time call in-progress trace display with message sequence diagram as required by the 
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network troubleshooting users, in as many network situations and contexts as possible. 
 Off-line tracing on stored data with at least 24HR back-search window capability 

 

       Note:  The amount of back search available depends on the amount of storage and the call            

volume of your network. 
 

  Easy tracing in advanced mobile networks or hybrid wireline PSTN/VoIP networks which can 
be very complex. Short-lived temporary identifiers allocated by networks makes tracing 
difficult (ex: TMSI, PTMSI) and are replaced in PIC by the identifier reference number that is 
based on a Tekelec patent. 

 Anticipates migration constraints, especially in terms of display possibilities and handling of 
SS7 LSL level 2/level 3 tracing. 

  Optimizes tracing process by taking advantage of enrichment techniques during capture. 
 

Configuring Network Views for ProTrace 

 
ProTrace allows you to trace customer calls or transactions over SS7, GPRS, Gb and other IP-

based networks. The application is capable of performing intra as well as inter-network/protocol 

tracing. The tracing feature of ProTrace is designed to start with a context of a Network View. 

 

This section provides an overview of configuring network views. The ability to configure ProTrace is 

limited to a user with the role NSPConfigManager. For more details on configuring ProTrace or the 

PIC System see the Centralized Configuration Manager Administration Guide. 
 

 

Network Views-Overview 
 

Network views are logical, user-defined groupings of elements in the PIC system and is used to 

denote some aspect, or perspective, of a customer network. For example, it could be the physical 

elements comprising a network, or at sub-networks, another carrier’s network or a certain type of 

traffic on the network. 

 

Network views can be nested and contain other network views that themselves may contain network 

views. Grouping elements together into network views allows you to divide up a network into more 

manageable units, not only for convenience (elements in a network view can be referred to from 

other parts of the system as a single unit, by referring to the network view) but also for authorization 

purposes. 

 

For example, a Network View might consist of all nodes in a particular region. This means that when 

you start with a context (selection) of that region you are able to trace the calls or transactions that 

are monitored from the nodes defined within region network view. In case of real-time trace of a 

mobile call where the location of the mobile is not known, you can select the entire network to start 

the trace. But if you know the location of the mobile call, you can select the corresponding node in 

the network view for faster access. 
 

Note:  The directionality of a call is in context of whether it is node-centric or eagle-centric. PIC is 

node-centric and all directionality is based on this orientation. 

 
 

Types of Network Views 
 

There are three types of network views handled by ProTrace. 
 

 Link views - that cover the management of linksets and links. 
 All Sessions - Shows all the sessions 
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 Session views - that cover management for xDR sessions. 
 

 

Setting up a Network View 
 

These are the general steps in setting up a Network view for ProTrace. 
 

Note:  The ability to set up network and link views in ProTrace is limited to a user with the role 
NSPConfigManager. 

Using CCM you: 
 

1. Create a site. 
 

(For more information on creating sites refer to the Centralized Configuration Manager Administration 

                Guide) 
 

2. Create a host on the site. 
 

(For more information on creating hosts refer to the Centralized Configuration Manager Administration 

                Guide) 
 

3. Create link/Session based on network view. 
 

(For more information on creating sites refer to the Centralized Configuration Manager Administration 
Guide.) 

 

Setting up a Link View 
 

Link-based network views (SS7) can be grouped together to create a view of the network that a system 

administrator can use for routing link data to the IXP and for other purposes. All links in an SS7 linkset 

are considered part of any network view containing the linkset. Network views can be hierarchical in 

nature. You can configure two types of link-based network views: 
 

Note:  The ability to set up Network and link views in ProTrace is limited to a user with the role 

NSPConfigManager. 
 

 Container Network View: A network view containing other network views. 
   Link Network Views: A network view containing one or more links of the type SS7 linkset. 

Using CCM you: 
 

1. Create a site 

2. Create a host on the site 

3. Create a Network Link View 

4. Configure the Network Link View 
 

For more information on these tasks see the Centralized Configuration Manager Administration 

Guide. 
 

 

Opening ProTrace 

 
Note:  NSP only supports versions of IE 7.0 or later and Firefox 3.6 or later. Before using NSP, turn  

off the browser pop up blocker for the NSP site. 
 

As an application on the NSP platform, ProTrace can be accessed from the  NSP application board. To 

open ProTrace you must first log into NSP. 
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Logging into NSP 
 

To log into NSP, you must first open the NSP Home Portal. To open the NSP Home Portal, follow these 

steps: 
 

1. Using a Web browser, type the  IP Address: http://<IP Address>/nsp 
 

Note:  Contact your system administrator for the IP Address where NSP and ProTrace reside.  
 

Table 7: NSP Portal Page 

 
Field 

 

 
Description 

 
User Name 

 

 
Your system identification for authentication to access NSP 
 

 
Password 

 

 
Unique identifier for user authentication 
 

 
 
 

 

 

 

 

 

 

 
Log into NSP by typing: 

a) Your Userid 

b) Your Password 
 

Note:  Check with your system administrator for your userid and password. 

 
2.   The NSP Application Board opens showing all currently deployed applications. 
 

 

Click the ProTrace icon (located in the Applications section) to open the ProTrace application. The 

ProTrace Home page opens. 
 

You can now begin using ProTrace. 

 

Understanding the ProTrace Interface 

 
The user interface for ProTrace is similar to that of other NSP applications. 

 

Note:  Do not use the Function Keys (F1 through F12) when using the NSP. Function keys work in  

Figure 10: NSP Portal 
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unexpected ways. For example, the F1 key will not open NSP help but will open help for the browser 

in use. The F5 key will not refresh a specific screen, but will refresh the entire session and will result 

in a loss of any entered information. 
 

For more information on the ProTrace screens, see: 

 The ProTrace Main Screen 

 Main Menu 

 Menubar 

  Header Section 

 

The ProTrace Main Screen 

 
The ProTrace main screen is divided into three main sections: 

 
 Menu - shows application menus 

 Network View Tree - lists all the sessions and link-based network views 

 Session List - list of current sessions 

 Query List - includes application toolbar 
 

. 
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Table 8: ProTrace Main Screen 

 
 
Section/Field 
 

 
Description 
 

 
Header 

 

 
This Section shows the : 
 

 Hide Banner feature - that lets you collapse the banner section 
(see 

 Banner section) 
 Link to NSP Platform Guide - this link opens the online help on 

how to use NSP interface and platform 
 User - shows the user name 
 Logout option 
 Client Logo 

 
   
Banner 

 

 
This section shows: 
 

  Application area 
  Option Menu Bar 

 
Note: This section can be hidden by clicking Hide Banner 
 

 
Toolbar 
 

 
This section shows all the feature buttons for each page. 
 

 
Network Tree 
 

 
Shows the two Network views 
Session - shows the xDR sessions in a network view 

    Link - shows all link-based network views 
    All sessions - shows all the sessions 

 
The Network Tree can be expanded or collapsed by clicking + or -. 
 

 
Session List 
 

 
Shows all the sessions for a network view or all sessions. 
 

 
Query List 
 

 
Shows all the queries for a network or session element. 
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Header Section 

The Menu section provides two menus as well as User Preferences and Logout functions. The Main menu 

and the Menu bar both are discussed in this section. 
 

Note:  For more information on working with User Preferences, click the link to the NSP Platform User 

Guide. 
 

Main Menu 

 
The menu section includes a navigation menu on the top left-hand side of the page. Figure 11: Main 
Menu shows the Main menu part of the Menu section 

 
Figure 11: Main Menu 

This menu brings you to the various application areas in NSP such as: 
 

 Home - the NSP Home page 
  Management/Surveillance - contains Management and Diagnostic Utility, Audit Viewer, Security 

and System Alarms 
  Applications - contains NSP Applications such as ProPerf, ProAlarm, ProTrace, etc. 

 

Menubar 

 
The Menubar is part of the Banner section and has five pull-down menus. 

 

Note:  This section can be hidden by clicking Hide Banner in the Header section. 
 

   File - that contains: 
 

 Import Trace - allows you to import trace files that were exported 
 

  Views - that contains the main functionality of ProTrace 
 

 Call Related - switches to Call Related view and displays all Call Related queries for selected 
 Network View 
 Non-Call Related - switches to Non-Call Related view and displays all Non-Call Related  

queries for selected Network View 
  Display Main Screen - Displays the main ProTrace screen 
  Preferences - opens a pop-up window for configuring ProTrace for more information, see 

Setting Preferences 

 

  Refresh Network Views - provides a means of refreshing the network views to give the latest 
information on network views. 
 

    Configuration - that contains: 
 
    EPI - provides a means of working with EPI configuration (protocols) for more information 

see EPI Configuration 
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 EPI Rules - enables you to set rules that govern the EPI for more information see EPI Rules 

 
    System Parameters - enables you to set various parameters for your traces such as: 
 

 Flex Matching Prefixes 
 Flex Number Length 
 Network Latency Interval 
 PDU Limit 
 QueryTimeout Limit 
 Refresh Interval 
 Trace Refresh Interval 
 Xdr Limit 

 

 
   Help - that contains: 

 
  Help - the online help system for ProTrace 
   About - provides information on the version of ProTrace 

 

 

 
Figure 12: ProTrace MenuBar 

 

Network view tree Section 
 

The Network View tree section functions as the directory for ProTrace and lists the network views  

from the Network View perspective. The headings entitled Sessions View shows the network views 

and the Link View shows all the link-based network views. 
 

 

Sessions list section 
 

The session list shows either all the sessions as a list, or a list of only those sessions associated 

with the network view selected: 
 

    All Sessions - This list shows all sessions in the system. With this view, you can select a single 
session and execute a query on the selected session. 

 Sessions View - This list shows the sessions associated with the selected network view. With this 
view, the sessions in the session list are not selectable. Any query that is run is executed on all 
sessions from the selected network view. 

  Links View - This list shows the sessions associated with the selected link-based network view. 
The sessions can be associated with a link-based network view in CCM. With this view, the 
sessions in the session list are not selectable. Any query that is run is executed on all sessions from 
the selected network view. 

 

 The session list contains 14 columns. You may need to scroll to see them all. Most of the column 
headings can be used to sort the displayed session list by clicking on the heading. Click once to sort 
in ascending order and again to sort in descending order for that column. 

 

The column headings are: 
 

 Session - session name. 

 Start Date - the start date and time for the session 

 End Date - the end date and time session 

 Record Count - the number of records in the session 

 Size (MB) - the approximate size of the session in the Oracle database 

 Dictionary Type - type of the dictionary 
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 Format - the format of the session 

 Protocol - the protocol of the dictionary 

 Dictionary - name of the dictionary used 

 Subsystem - the subsystem where the session is built and stored 

 User Information - any other information about the session 

 Owner - the owner of the session 

 Creation time - the date the session was created 

 PC Format- Point Code Format associated with Session. 

Note: If Session Point Code Feature is enabled then session listing will also show PC 

Format as one of the fields otherwise “PC Format” field will be absent. 

Note: Point Code Flavors supported are 

 Default 

 ANSI 

 ETSI N 

 ETSI I 

 Chinese 

 Japanese 

Some of the columns have a Quick Filter pull down you can select to only display sessions with 

that trait. For example, to only see sessions that use the ISUP ANSI protocol select ISUP ANSI 

from the Protocol pull down. The columns that can be used for quick filters are: 
 

   Dictionary Type 
    Format 
    Protocol 
    Dictionary 
    Subsystem 

 
Note:  The Start Date, End Date, Record Count and Size information is not displayed 

automatically, and these columns may be empty. To get these values, click the Obtain Session 

Period icon in the session list toolbar. This will not necessarily update the Record size and Record 

Count Information, as that information is only updated during the Oracle nightly job. 

 
Figure 13: Session List with Session Point Code Enabled 
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Sessions list Toolbar 

The toolbar provides a means of selecting and organizing xDR sessions. Below is a description of 

each button on the toolbar. 
 

 
Filter - clicking this button opens the System Query Dialog popup where you can filter the list 

of sessions displayed by the various columns and their values. 
 

 First page - clicking this button opens the first page of sessions. 
 

 Previous page - clicking this button opens the previous page of sessions. 
 

 Next page - clicking this button opens the next page of sessions. 
 

 Last page - clicking this button opens the last page of sessions. 
 

 Set Size - use this button to set the session list size from 10-20,000 per page. 
 

 
 Refresh - clicking this button re-loads the current screen and shows any changes that have 

been made. 
 

 Export - clicking this button opens up the Export popup window. 
 

 
 Permissions - use this to set the permissions for accessing the sessions. You must be a user 

with the role NSPConfigManager to set permissions. 
 

 
 Obtain Session Period and Size - clicking this button re-loads the current screen and 

updates the Session Period and Session Size columns. 
 

Note:  Obtaining the session period can be time consuming. To improve performance, reduce the  

number of sessions in the list by using a filter. 
 
 

 Multilink - clicking on this button opens the multilink popup screen where you can select 

more than one link to filter. 
 

 
 Selected Session or Network view - This icon shows the session or network view you 

have selected. Hover over the icon to see the type of the selected session or network view. 

In addition to these buttons there is also a saved filters pull-down you can use to select a saved 

filter, and a page count showing what page out of the total sessions pages you are viewing. 
 

Query list Section 

 

The query table contains five columns. The table queries change depending on what view is 

selected 

(According to the protocol selected or included in the sessions view) but the columns are 
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constant. Most of the column headings can be used to sort the list by clicking on the heading. 

Click once to sort in ascending order and again to sort in descending order for that column. 

 

The column headings are: 
 

 Query Name - that shows the name of the query 

 Owner - shows the user name that created the query 

 Replaced by - shows the user who last modified the query 

 Creation time - shows the date the query was created 

 

Query list Toolbar 

The toolbar provides a means of selecting and organizing queries. 

Below is a description of each button on the toolbar. 
 

Filtering Mode/In Progress Trace - clicking this button toggles between Filtering Mode and In 

Progress Tracing. The button name will change to reflect this. 
 

 
  Filter - clicking this button opens the System Query Dialog page where you can filter out all 

non-essential queries. 

 

 First page - clicking this button opens the first page of queries 
 

 Previous page - clicking this button opens the previous page of queries. 
 

 Next page - clicking this button opens the next page of queries. 
 

 Last page - clicking this button opens the last page of queries. 
 

 Set Size - use this button to set the queries list size from 10-500 per page. 
 

 
 Refresh - clicking this button re-loads the current screen and shows any changes that have 

been made. 
 

 Export - clicking this button opens up the Export window. 
 

 Create - clicking this button opens the Query Dialogue screen to add a specific query. 
 

 Modify - clicking this button opens the current query for modification. 
 

 Delete - clicking this button deletes the current query. 

 
 
 

 
 Add To Hotlist - clicking this button adds a query to the Hot List. A hot list is a list of 

frequently used queries that is separate from the total list of queries. 
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  View - clicking this button enables you to toggle the display mode between all queries and 

only the Hot List queries. This feature is especially handy when you have very large lists of queries. 
 

 Execute query - clicking this button runs the selected query on the selected network 

view. 

 

 
 Execute link query - clicking this button runs an empty query on the selected link-

based network view or on the selected links. 
 

 
 Permissions - clicking this button opens the Permissions Dialogue page that shows what 

privileges you have on the selected query and allows you to manage queries you have 

permission to access. 

 

In addition to these buttons there is also a queries count showing how many queries are in the 

list and what range you are viewing. 
 

xDR Viewer Page 

The xDR viewer page shows the results of a query. 

 

 
Figure 14:xDR Viewer Page 

The xDR viewer page can be divided into several different Layouts. 

 

If you want to see the PDU and the PDU decode each in a separate window, you can set the 

xDR viewer layout to single window and double click on an xDR. This will display the list of 

PDUs in a separate window. Subsequently, you can double click on a PDU to see it’s decoded 

in a separate window as well. 

 

Note:  Only one PDU and decode window can be open at one time. 

Note: If Session Point Code Feature is enabled then 

 On focusing on Point Code field cells the tooltip should display the flavor according to 

which the Point Code Value has been formatted. 
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 The Point Code Fields in the Result Set are formatted according to the User 

Preferences Format of the Flavor used in the Query. 

 

 

xDR Viewer Toolbar 
 

Each of the function buttons unique to the xDR viewer toolbar is described separately.  

 
 
 

 Select Column - enables you to select what columns are displayed in the table as well 

as what order they appear in. 
 

 First row - clicking this button selects the first record row on the page. 
 

 Previous row - clicking this button selects the record row directly above the current record.  
 

 Next row - clicking this button selects the record row directly below the current record. 
 

 Last row - clicking this button selects the last record row on the page. 
 

 First page - clicking this button opens the first page of queries 

 

 Previous page - clicking this button opens the previous page of queries. 

 

 Next page - clicking this button opens the next page of queries. 

 

 Reverse Sorting - clicking this button reverses the sort order of the xDR list. 
 

 
 

Set xDR Page Size - this shows how many xDRs are displayed per page, you can modify the 

number of xDRs on the page by typing in another number and clicking the check to the right. 

You can set the page size from 10 to 20,000 xDRs per page (when using Applet Table, 

otherwise page size can be from 10-5000). A larger page size will take longer to display. You 

can also increase the display speed by reducing the number of columns shown. In addition, 
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when you place the cursor on this icon, you get: the current page, the position (number), how the 

xDR is sorted and the number of xDRs on a page. 
 

 
 Pause refresh - stops automatic refresh so that you can work on filters or records 

without data changing. 
 

 Cancel - cancels the current process. 
 

 Display Main Screen - closes the current query and opens the initial query list page. 

 

 Start trace - executes a trace process. 

 

 Modify filter - opens the Query dialog screen of an existing query. 

 

 Recall filter - reruns the query using original filter. 

 

  Explain Plan - displays the detailed plan information. 
 

 XDR Finder - Opens the XDR Finder window. 
 

 Export - opens up the Export window. 
 

 Direct Excel Export - Exports directly to Excel. 
 

 Search - searches for specific xdr records. 

 

 Next search - continues search of xdr records. 

 

  Copy PDUs/Decoding - Copies the selected PDU or decoding information. 

 

 

 Change layout - enables you to change the page layout using a variety of combinations. 

See Figure23: Layout Button with Layout Choices 

  Session/Network view Selected - Shows the session or network view that is selected. 

 

 
 Query selected - clicking on this icon opens a small information pop-up showing the 

name and description of the query being run (see Figure 31: Query with Multiple Conditions for a 

view of the query information pop-up). 
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Column Heading Descriptions 
 

ProTrace xDR page has a rollover function that shows the column description when the cursor is 

placed on the column heading. The column being described is underlined. The figure shown here 

shows an example of the rollover feature. 

 
 

 
Figure 15: Column Heading Description Feature 

 

Sorting by Columns 
 

In the xDR viewer, you can sort by columns. To sort by column heading place the cursor over the 

Column Heading and click on it. The displayed records for that page (not the entire set) are 

sorted according that heading. If you click the heading again, the sort order is reversed. 
 

 

Hidden xDRs, PDUs and Decoding 
 

xDRs, PDUs and PDU decoding can be hidden in ProTrace. The ability to hide xDRs, PDUs and 

PDU decoding is configured in CCM (for more information see the Centralized Configuration 

Manager Administration Guide) from the Home page or the Mediation perspective. The following 

data can be hidden in ProTrace. 
 

Note:  For users with role NSPBusinessUser or NSPBusinessPowerUser if Decode layer is set to 

Hide or Summary, then all hex codes for that layer will be masked (hex numbers replaced by **). 
 

 xDR Hiding 
 

Fields 

Number of characters (up to total number of 

characters) Columns 
 

 PDU Hiding 
 

   Fields 

Number of characters (up to total number of 

characters) PDU Summary 
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 PDU Decode Hiding 

Hexadecimal values (header of the 

decoding section) Columns 1, 3 and 4 
 

PDU decode title (column 2) 
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Chapter3: Setting ProTrace Preferences 
 
 
 

 

 

 Overview 

 Configuring Trace Display Preferences 

 System Parameters 

 EPI Configuration 

 EPI Rules 

 Changing the Page Layout 

 Setting User Preferences 
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Overview 

 
This chapter provides information on setting preferences, system parameters, EPI settings, and 

Page Layout in ProTrace. 

Configuring Trace Display Preferences 

 
The ProTrace View menu contains a Preference option that enables you to configure attributes 

and decode colors. 

Opening the Preference Option 

 

To open the Preference option: 

From the menu bar Select View > Preferences, the Preferences page opens shown in  

 

 

 

 

Figure 16: Preferences Page 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

Figure 16: Preferences Page 

The Preferences page has five tabs. They are: 
 

 Decode Color - enables you to customize the colors for protocol errors, outgoing 

signal unit, incoming signal unit, etc. 

 Decode Layers - enables you to hide, show a summary or show detail of records 

 Default Fields - enables you to select fields for each protocol, that are displayed during 
filtering 

  Tracing Protocols - enables you to specify if the xDRs and PDUs of each protocol will be 
displayed in trace. 
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Note:  In "Trace Viewer" you have an option to modify the "tracing protocols" selection 

for a particular trace. See Managing Protocol Filters 

  . 

 Other - enables you to select the option of enabling flex matching, and to enable a Java 
Applet for displaying xDR tables. 

Setting Preferences 

 

Follow these general steps to set ProTrace preferences.  
 

1. Select View ->Preferences, the Preferences page opens. 
 

2. Select the Tab where modifications are to be made. 

3. Make the desired modifications (setting colors or enabling/disabling a feature). 

 

4. Click Apply. 
 

The modifications are saved. 
 

Note:  To reset the preferences to default settings, click Reset. 

 

Note:  For users with role NSPBusinessUser or NSPBusinessPowerUser if Decode layer is set to 

Hide or Summary, then all hex codes for that layer will be masked (hex numbers replaced by **). 

 

Configuring PDU decode Colors 

 

This feature enables you to configure PDU decode color preferences. Follow these steps to 

configure decode color preferences. 
 

1. From the menu, select View -> Preferences. 
 

2. Select the Decode Colors tab. 
 

3. Changes decode colors in Layer 1 and Layer 2. 
 

4. Click Apply the colors are set for this preference. 
 

 

Enabling and Disabling Flex Matching 
 

This function enables or disables extended matching during tracing. With flex matching you can filter 

on a subset of address digits. 
 

Flexible Matching is available for all filters and traces, (whether predefined or not), when address 

digits are involved. 
 

Note:  The field (EPI) will be queried by flex matching if the "Flex Matching" function is enabled 

and if a given EPI is enabled for flex matching. (See Configuring EPIs 
) 

Note:  Enabling of flex matching function has a strong impact on performance. 

Complete these steps to enable the Flex matching feature. 

 
1.   From the menu, select View -> Preferences. 

 

2.   Select the Other tab. 
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3.   Click the Flex matching check box. 
 

4.   Click Apply. 

Flex matching is enabled. 

 

System Parameters 

The System Parameters feature enables you to set the following functions: 

 

 Flex Matching Prefixes - (default - none) a semi-colon separated list of prefixes, for 

example, 0; 31; 0031 or none if turned off.  

 
 FlexNumber Length - (default - 0) length of the pattern number used for analysis 

without a prefix, for example, if set to 9, ProTrace will try to find the same pattern of 9 

consecutive digits. 
 

Note:  These two parameters are related to the Flex Matching function for tracing. 

When these two parameters are not set (FlexMatching Prefixes=When 

FlexMatchingPrefixes) and FlexNumberLength is set, then the flex matching is 

restricted to the prefixes from FlexMatching Prefixes. (See Enabling and Disabling 

Flex Matching 
  for more information). 

 
 Network Latency interval - range 5 seconds with no upper limit (default 10 

seconds). The time (in seconds) between when the last MSU is captured and the 

xDR are generated and appear in the database. This is crucial for real-time. The 

xDRs have timestamp X, but it appears in the database in time X+latency. If the 

NetworkLatency is less than real latency then we may miss some XDRs, if it is 

dramatically more than the real latency, we have to search a bigger interval and the 

query may take longer depending on the traffic. 

 Trace Latency - (in seconds, default 0) When starting an in-progress call trace, this 

parameter extends (to the past) the time interval in which ProTrace searches the 

xDRs from the initial query.(the query used when starting the call trace). For 

example: when Trace Latency is set to 600, and in-progress call trace is started with 

an ISUP query, ProTrace will extend the search for ISUP calls 10 minutes back into 

the past. This may result in finding partial xDRs for calls in progress as well as final 

xDRs of already finished calls. 

  PDU Limit - is the maximum number of PDUs allowed to display in the PDU view 

(the second view) of Trace Viewer. If the number of PDUs exceeds the limit the trace 

is stopped (default is 5000). 

 Query time out limit - (default 600 seconds) provides a time limit for the query to 

run. 

  Refresh interval - (default 10 seconds) the refresh time interval (in seconds) for the 

XDR Viewer (filter results) in real-time filtering. After this interval the query is re-

executed and new results displayed. 

   Trace Optimization - (default - 2) defines the Oracle optimization for tracing 

queries. 

 
 0 - Oracle will decide on its own optimization based on internal Oracle indexes. 

 1 - Oracle will access the rows using TimeTag index instead of field indexes. 

 2 - Default value, supposed to give the best performances. It uses field indexes 
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when it is possible for all EPIs. If any field is not indexed, then StartDate/TimeTag 

indexes (TO-1) is automatically used. 
 

    Trace Refresh Interval - the refresh time interval (in mili-seconds) for the Trace 

Viewer (trace result). In this interval the Trace GUI is updated and displays new 

xDRs and PDUs which belong to the call/transaction (default 10 seconds). 

   XDR Limit -maximum number of xDRs allowed displaying in the XDR view (the first 

view) of Trace Viewer. If the number of XDRs exceeds the limit (1000) the trace is 

stopped. 
 

1. To open the System Parameters screen, select Configuration > System Parameters. 
 

 

 
 

Figure 17: System Parameters Screen 

 
 

2. To set ProTrace parameters, type in a specific value (number) or time interval, (in seconds or 

milliseconds), suitable for your traces for each of the parameters and click Apply. The changes 

are saved. 

EPI Configuration 

 
End Point Identifiers (EPI) are the fields used in a scenario-less tracing to correlate between 

different protocols or legs of a call/transaction/session. 

Defining a field as an EPI means that the value contained in this field will be taken into account to 

correlate other records based on this value. This means that an EPI must not be too generic (for 

example, a Calling SCCP Address is not specifically related to a customer but to many 
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transactions). Also, it is very important to adapt EPI rules to avoid having too many records not 

related to the trace found by the system. This can happen if a field defined as an EPI (such as an 

MSISDN) is filled by a “generic” value. In this case, the content of the field should not be kept as a 

value to use for further queries.  

 

Note:  EPI configuration is only available to users with NSP Administrator privilege. 

Configuring EPIs 

 

Follow these steps to configure EPIs. 
 

1. Select Configuration > EPI. The EPI screen opens. 
 

 

2. Select a Protocol from the pull-down menu. 
 

The screen changes to show the parameters for that protocol. 

 
3.  Fill in the Protocol Time Parameters. 

The Protocol Time Parameters define the time range used for searching for new xDRs. 

This time range is related to BEGIN TIME and END TIME of discovered xDRs and uses a 

Positive and a Negative value. 

The ranges for both positive and negative rules are 2-90000 seconds. 
 

The Guaranteed length parameter allows you to enhance the search period to 

END_TIME + Guaranteed length. This parameter is used for search optimization and 

corresponds to the longest call or transaction the system is guaranteed to find. 
 

4.  Select (or de-select), the EPI parameters for that protocol. 
 

 Flex - defines whether the "Flex matching" is used for given field (see Enabling 
and Disabling Flex Matching 

 Enabled - enabling/disabling the particular field as EPI 
 

5.   Click Apply. The changes are saved. 

EPI Rule Classes 
 

EPI rules should be used to "clean-up" the results of a call trace and limit the hits when tracing a 

call. For instance, an EPI rule can be constructed to exclude some numbers in call tracing, for 

example, the short number for calling voice mail. 

 

Note:  EPI Rules follow Java Regular Expressions. 

 

Rule Classes and Explanations: 

 

 

Character Classes (bracket expression) 

 

 

[abc] 

 

 

a,b or c (simple class) 

 

 

[^abc] 

 

 

Any character except a, b or c (negative) 
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[a-zA-Z] 

 

 

a through z, or A through Z, inclusive (range) 

 

 

[a-d[m-p] ] 

 

 

a through d ,or m through p [a-dm-p] (union) 

 

 

[a-z&& [def] ] 

 

 

d, e or f (intersection) 

 

 

[a-z&& [^bc] ] 

 

 

a through z, except for b and c: [ad-z] (subtraction) 

 
 
[a-z&& [^m-p] ] 

 

 
 
a through z, and not m through p: [a-lq-z] (subtraction) 

 
 
 
 
Predefined Character Classes 

 

. Any character (may or may not match line terminators) 
 

 
\d 
 

 
            A digit: [0-9] 

 
\D 
 

 
A non-digit: [^0-9] 

 
 
\s 
 

 
A white space character: [ \ t \ n \ x0B \ f\ r ] 

 
 
\S 
 

 
A non-white space character: [^ \ s] 

 
 
\w 

 
A word character: [a-zA-Z_0-9] 

 
 
\W 

 
A non-word character: [^ \ w] 

 

 

Rule classes combined with Meta characters: 

 

 
Meta character 

 
Meaning 

X? 
 

X, once or not at all 
 

X* 
 

X, zero or more times 
 

X+ 
 

X, one or more times 
 

X{n} 
 

X, exactly n times 
 

X{n,} 
 

X, at least n times 
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X{n,m} 
 

X, at least n but not more than m times 
 

 
 
 

Protocol Time Parameters for EPI Rules: 

Protocol time parameters allow some tolerance in the time comparison done in finding matching 

xDRs. The time comparison rule for a given EPI "X" found in xDR with start time "S" and end time 

"E" is: LOOK for X where TIMETAG between (S;E) OR START_DATE between (S;E) 
 

Note: TIMETAG = End Date 

Two examples of protocol time parameter use 
 

•   Negative (2-90000) and Positive (2-90000) effect 
 

The time protocol tolerances fields (called here negativeT and positiveT) are used to determine the 

time range for the search. 
 

The extended rule will be: 

LOOK for X where TIMETAG between (S - negativeT; E + positiveT) OR START_DATE 

between (S - negativeT; E + positiveT) 
 

This comparison of time is based on each xDR from which a new query is launched to find other xDRs 

(Based on EPI values found in the xDR). 
 

•   Guaranteed length (-1-90000) effect 

The concept of guaranteed length is used to give better guarantee to find "long transactions." 

This guaranteed length extends the query to: 
 

LOOK for X where TIMETAG between (S - negativeT; E + positiveT) OR 

[START_DATE between (S - negativeT; E = positiveT) and TIMETAG between (S 

- negativeT; E + positiveT + GUARANTEED_LENGTH)] 

 
Figure 18: Graphical Representation of Guaranteed Length 

 
The goal is to limit the search duration, by giving boundaries for the "end" of the search within an 

identified limit, as on the one hand, there are possibilities of long transactions, and on the other hand, 

(Because of the data storage mechanism), it optimizes the query efficiency. The value of this parameter is 

given in seconds. 

The value "-1" means the system takes a default value that is 2 hours (7200 seconds). 

EPI Rule Examples 
 

These are two examples of using EPI rules. 
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In the first example there are two rules stated: 
 

 Do not consider as a valid EPI, all values like FF, FFFF, etc. 

 Do not consider as a valid EPI the value 888, for example in a voice mail number. 
 

 
Figure 19:Example1 of EPI Rule Usage 

In the second example a rule that states: 
 

 Ignore for all protocols when a B_Number starts with 65 (considered as a prefix) followed 

or not by several digits. 
 

 
Figure 20: Example 2 of EPI Rule Usage 

EPI Rules 

 
ProTrace also provides a means of setting up EPI filtering rules that help you select specific records  

to trace. The following recommendations apply to EPI rules. 
 

•   If the EPI candidate passes the positive rule, it is considered as true EPI and no other rules are 

checked and the process is finished. 

•   If the EPI candidate passes the negative rule, it means that the tested EPI is not a real EPI and it is 

ignored. In both cases if the rule doesn't pass, the next rule is tested. 

•   If there are no other rules, the candidate is validated as the real EPI (the implicit rule is that every 

EPI is valid). 
 

Note:  EPI rules can only be configured, modified or deleted by users with NSP Administrator 

privileges. 

Configuring EPI Rules 

 
Complete these steps to configure the EPI rules for your system. 

 
1. Select Configuration > EPI Rules. 

 

The EPI Rules screen opens shown in Figure 21: Epi Rules Screen 
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Figure 21: Epi Rules Screen 

 
 

 
2. Click Add. 

 

The screen change to add another row shown in Figure 22 : Epi Rules Screen Add 
 

Note:  Adding a rule provides you with ways to broaden or narrow your traces. 
Note:  *’s signify wildcards. To specify specific rules you select from the options in each of the 

fields. 
 

 
Figure 22 : Epi Rules Screen Add 

 
3. Double-click on the row to open the fields. 
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4. Select the Protocol from the pull-down list. 
 

5. Select the EPI Name from the pull-down list. 
 

6. Select whether the rule will be Positive or Negative (see EPI Configuration 
 

 

7. Type in a specific Pattern for the rule. 
 

Note:  Type a specific Pattern for the rule. The pattern form is defined by "Java Regular Expression" 
rules. Here is an example: 
http://java.sun.com/docs/books/tutorial/essential/regex/ 

 
8. Click Apply. 

a. The rule is saved to the system. 
 

9. Click Close to close the screen. 
 

Modifying an EPI Rule 

 
Complete these steps to modify an existing EPI rule. 
 

1.   Select Configuration > EPI Rules. 
2.   Select a rule and double-click on it. 

The record row changes to show pull-down lists.  
 

3.    Make the appropriate modifications to the rule. 
 

4.    Click Apply. 
The modifications are saved to the system. 
 

5.    Click Close to close the screen. 
 

 

Deleting an EPI Rule 
 
Complete these steps to delete an EPI rule. 
 

1.   Select Configuration > EPI Rules. 
 

2.    Select the Rule to be deleted. 
 
3.    Click Delete. 

 
4.  Click Apply. 

The rule is deleted from the system. 
 

5.   Click Close to close the screen. 
 

Changing the Page Layout 

 
You can change the page layout of the XDR viewer (or Trace viewer) to re-arrange or hide the xDR, PDU, 

and Full Decode views. To change the layout follows these steps. 

 

Note:  Only users with the NSP Business Manager privileges can change the layout. 

 
1. Click Change Layout. 
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The layout pop-up opens. 

 
Figure23: Layout Button with Layout Choices 

 
2. Select a Layout. 

The page layout changes to match your choice. This will now be the default layout for this session 

type. 

Setting User Preferences 

 

User Preferences feature provides a way to configure the following parameters: 

 
 Time format 

 

 Directory 

 Mapping 

 CIC settings 

 Point Code 

 Default Period 
 

Setting Time Format 
 

Follow these steps to set the time format. 
 

1. Click User Preferences on the Application board 

page. The User Preferences page opens. 
 

2. Select the Time tab to open the Time formatting interface. 
 

Note:  You can follow the Tips provided on the page to help you configure the time format to your 

needs. 
 

3. Select the “Date Format” format. 
 

4. Select the “Time Format” format. 
 

5. Select the Date and time fields format. 
 

   (Optional) Select the Duration fields format. 
 

   (Optional) Select the Time zone. 
 

Note:  You must set the time to the correct location to get correct time. 
 

6. Click Apply to save settings. 
 

Note: To reset the time format to default settings, click Reset Tab. 
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Setting Enumeration Preferences 
 

You can set the Mapping settings using the User Preferences feature. Mapping is used by xDRs to 

display the text values instead of numeric values. 
 

Follow these steps to set enumeration Mapping preferences. 
 

1. Click User Preferences on the Application board 

page. The User Preferences page opens. 
 

2. Select the Mapping tab to open the Directory interface. 
 

3. Check Translate ENUM values if you need to translate values. 
 

4. Click Apply to save the changes. 
 

5. (Optional) You can click Reset Tab to reset the default values. 
 

 

Setting Point Code Preferences 
 

The User Preferences feature enables you to set the Point Code preferences for your system. A 

Point Code is a unique address for a node (Signaling Point), used to identify the destination of a 

message signal unit (MSU). 
 

Follow these steps to set the Point Code preferences. 
 

1.   Click User Preferences in the Application board. 

The User Preferences page is displayed. 

 
 

2.   Click the Point Code tab. 

The Point Code page is displayed. The red asterisk denotes a required field. 

 
Figure 24: Point Code Tab 
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3.   Select either Hexadecimal display or Decimal display. 
 

 

4.   Select or de-select Split format. 

If Split format is checked, the Bit groups settings in the box below are active. If Split format is not 

checked, Bit groups settings are not applicable. 

5.   If you selected Split format above, go to the next step. If you did not select Split format, go to step 
Step8. 

 

6.   In the Bit groups panel, use the drop-down box to select the Separation type . 
 

7.   Type in values for Groups 0-3. 
 

8.   To reset the point code preferences to default settings, click Reset for Point code. (The bottom 

Reset button resets all the tabbed pages to default settings.) 
 

9.   Click Apply to save your settings. 
 

Note: if Session Point Code feature is enabled the Point Code tab will look like : 

 

Figure 25: Point Code Tab with Session Point Code Enabled 

 

User can follow the same steps mentioned above for setting preferences  
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Setting CIC Preferences 
 

The Circuit Identification Code (CIC) provides a way to identify which circuit is used by the MSU. 

You can use the User Preferences feature to set the CIC settings for your system. 
 

Follow these steps to set the CIC preferences. 
 

1.   Click User Preferences on the Application board page. 
 

The User Preferences page opens. 
 

2.   Select the CIC tab to open the CIC interface shown in. 
 

3.   Select the type of CIC (Hexadecimal, Decimal). 
 

4.   Select or de-select Split format. 
 

5.   Select the Bit group Separation (if split format is selected). 
 

6.   Type in the values for Group 0 and Group 1 values. 
 

7.   Click Apply to save your settings. 
 

Note:  To reset the time format to default settings, click Reset Tab. 
 

Note:  The North American defaults are: 

a)  CIC = Decimal display 

b) Bit groups 
 

 Group 0:8 

 Group 1:8 
 

 

Setting Directory Preferences 

You can use the User Preferences feature to set the Directory preferences for your system. 

Follow these steps to set the Directory preferences. 
 

1.   Click User Preferences on the Application board page. 

The User Preferences page opens. 
 

2.   Select the Directory tab to open the Point Code interface. 
 

3.   Enter the exact path of the Export Directory, Upload Directory, and/or the Download directory. 
 

Note:  These directories must exist on the server for the Export, Upload/Download to 

work correctly. 

 
4.   Click Apply to save your settings. 
 

 

 

Setting Default Period Preferences 

The User Preferences feature enables you to set the Default Period preferences for your system. 

Follow these steps to set the Default Period preferences. 
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1.   Click User Preferences in the Application board. 

The User Preferences page is displayed. 
 

2.   Click the Default Period tab. 

The Default Period page is displayed. 

3.   Enter the Default Period in hours. 
 

4.   Click Apply to save your settings. 
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Chapter 4: Transaction/Call/Data Traces 
 

 

 
 

 Trace Overview 

 Filtering Modes and Managing Queries 

 xDR Viewer 

 Exporting Results 
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Trace Overview 

 
ProTrace provides you with the ability to perform a trace in order to identify a particular customer or 

network related problem. You can identify the customer-related problem by starting a trace based on 

customer-related identifiers. For the historical customer-related trace, you initiate the trace by 

performing two steps. 
 

The first step is to filter the xDRs based on the user-defined criteria. For example, you create a filter 

to list all the xDRs whose ANumber = 9192436596. ProTrace lists all the xDRs for completed calls. The 

second step is to select a particular xDR and start a trace. 
 

For the real time customer related traces, you enter the customer identifier for the protocol(s) to be 

traced (See EPI). Based on the identifier you specify, ProTrace has the capability of tracing the 

transactions, calls and data sessions that transcend intra or inter protocols. ProTrace starts the trace 

in response to the customer/terminal identifier specified by the actor, for example, ANumber, MSISDN, 

IMSI, IMEI, SIP@, etc. 
 

In addition, you can identify network-related problems by starting a trace based on network-related 

identifiers. As with historical customer traces, you go through a two-step process to initiate a 

network-related trace. 
 

The first step, is to filter the xDRs based on the user-defined criteria. For example, you create a filter 

to list all the xDRs whose CAUSE VALUE = ‘Unsuccessful’. ProTrace lists all the xDRs for completed 

and in-progress calls. In the second step you select a particular xDR and start a trace. Based on the 

chosen xDR, ProTrace has the capability of tracing the calls, data sessions and transactions that transcend 

intra or inter-protocols. In achieving a network-related trace you manage (create, modify, delete) 

protocol filters that enable you to create simple or complex filters. In addition, you can focus on a 

particular xDR data set and choose the desired xDR for starting a trace. Executing the filter results in 

an xDR Viewer display enabling you to browse xDRs and choose the desired one for initiating the 

trace. 

Filtering Modes and Managing Queries 

 
You obtain the information you want by creating and managing queries. ProTrace provides a wizard 

to help you create queries. Once a query is created, you can run, modify or delete the query. 
 

When using ProTrace queries there are two modes available: Filtering Mode and In Progress Tracing, 

which are selected using the Filtering Mode/In Progress Trace toggle button in the Query list toolbar. 

When ProTrace is in Filtering mode, executing a query will always display the XDR viewer with result 

of the query. 
 

When ProTrace is in In Progress Tracing mode, executing a query will always start a real-time trace 

in the Trace viewer. In this mode you can only create a trace query with EPI conditions using only the 

equal operator. 
 

Note:  In Progress Tracing may not be available depending on your product licensing and installation. 

Note:  If an IXP storage server is in "Query" state, no configuration actions can be undertaken. All 

servers must be in "Active" state when sessions are created for queries on such sessions to be successful. 

Otherwise, if a query is launched in ProTrace on a newly created session, a "Unable to execute query: 

ORA-00942: table or view does not exist." will appear. 
 

Naming and Describing a Query 

 

Complete the following steps to name and describe a query. 
 

1.   Select a session from All Sessions or Network View. 
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A list of saved queries compatible with the selected session or network view is displayed. 
 

Note:  The query list is filtered based on your privacy rights. 
 

2.   Click Create to create a new query. 

The Query dialog opens. 
 

3.   Type in the Name of the query. 
 

4.   (Optional) Type in a Description of the filter. 

This is useful if the filter is shared with other users. 

Adding One or More Dictionaries to a Query 

 

Note:  Dictionaries are discovered in CCM and imported into ProTrace. 
 

When creating a query, you can add one or more dictionaries. This enables you to select one or 

more protocols for your queries. After you have named and described the query, can select one or 

more Dictionaries for the query. Complete the following steps to add dictionaries to a query. 
 

1.   In the Available dictionaries field, select the Dictionary for the filter. 
 

2.   Click the Add button beside the Available Dictionaries field. 

3.   Repeat steps 1 and 2 to add additional dictionaries. 

You can add multiple dictionaries. For each dictionary selected, another tab appears with the name 

of the dictionary. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
              Figure 26: Query with a Dictionary Selected 

 

Creating Conditions for a Query 
 

You can fine-tune your query by creating conditions. Complete these steps to add a condition to your 

query. 
 

1.   Select the Dictionary tab for the condition you want to create. 
 

Note:  If there are multiple dictionaries for the filter, create the conditions for each dictionary 

separately. 
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Figure 27: Dictionary Screen 

 

2.   Click Add (located on the bottom section of the screen) to create a condition for the filter. 

The condition fields appear on the Dictionary screen. 
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Figure 28 : Dictionary Screen with one condition for A-number 

 
3.   Select a Field from the field list. 

 

You can mouse over the question mark icon next to the Field pull down to see information about 

the selected field. 
 

Note:  Indexed Fields are highlighted in Red. 
 

 
Figure 29: Example of Indexed Fields 

4.   Select an Operator from the Operator field. 

You can mouse over the question mark icon next to the Operator pull down to see information 

about the selected operator. 
 

Note:  The only operators that are listed are those that can be used with that field. 
 

5.   Select or enter a value for the condition. 
 

Note:  For example, all A-numbers greater than 000-000-0000. 
 

At this stage you can go to the Displayed Fields tab to select the fields you want or you can create 
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more conditions. See Creating Multiple Conditions for a Query 
 to create multiple conditions. 

 

Note:  To find records with a NULL property, make sure to use "equals NULL" condition. For 

example, MSISDN = NULL. 
                Note:  

 The format supported for IP-V4 is as usual 4 groups in decimal separated by ‘.’ 
: xxx.xxx.xxx.xxx. 

 The format supported for IP-V6 fields is 8 groups in hexadecimal separated by ‘:’ 
with canonical way  
xxxx: xxxx: xxxx: xxxx: xxxx: xxxx: xxxx: xxxx 

 It will be possible to use prefixes notation to be able to find range. This will be 
available for IPV4 and V6. 
For Example: 1082::8:800:200C:417A/11  
Will search all IPs between  
'10800000000000000000000000000000' AND 
'109FFFFFFFFFFFFFFFFFFFFFFFFFFFFF' 
 

 Note:  If Session Point Code Feature is enabled: 
 For all the Query Conditions with Point Code fields the Value Drop Down displays 

"Please Specify other in <flavor> format" where <flavor> is the Session Flavor in 
case of Session Query 

 In case of Network View the Drop Down should display an entry each for the 
distinct possible flavors of all the sessions constituting the Network View. 

 On selecting a Flavor Item, Text Box should display [<flavor>]. User should be 
able to enter the Point Code Value after that. 

 

Creating Multiple Conditions for a Query 
 

ProTrace provides specific Operators that you can use when creating multiple conditions for a query. 

Complete these steps to create multiple conditions. 
 

Note:  If you have multiple dictionaries you can create conditions for each dictionary. 
 

1.   Select the Dictionary for the condition you want to create. 

2.   Select the Operation to be used for the condition. 

You can select any one of three operations. 
 

 And 

 Or 

 Use Brackets (if you want to tailor your filter for specific operators.) 
 

Figure 30:Query Dialog With Session Point code Enabled 
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The figure shows a query with multiple conditions and an operator. The expression for the query 

is shown in the expression field. 
 

3.   To create a new condition, click Add (located on the bottom section of the screen). 
 

4.   Select a Field from the Field list. 
 

5.   Select an Operator from the Operator field. 
 

Note:  The only operators that appear are the ones allowed with the field. 
 

6.   Select or enter a value for the field. 
 

Note:  Acceptable values are validated against the data type of the field. You have an option of 

entering wild card characters such as: "*" or "?". In addition to wild cards, you can use "~=" for 

address Digits and enter the subset of digits to use the Flex Matching feature. Lastly, for address 

fields like CdPN, CGPN, redirecting number, dialed digits and routing number, you also have the 

option of entering the HEX digits like B, C and D. 
Note:  

 The format supported for IP-V4 is as usual 4 groups in decimal separated by ‘.’ 
: xxx.xxx.xxx.xxx. 

 The format supported for IP-V6 fields is 8 groups in hexadecimal separated by ‘:’ 
with canonical way  
xxxx: xxxx: xxxx: xxxx: xxxx: xxxx: xxxx: xxxx 

 It will be possible to use prefixes notation to be able to find range. This will be 
available for IPV4 and V6. 
For Example: 1082::8:800:200C:417A/11  
Will search all IPs between  
'10800000000000000000000000000000' AND 
'109FFFFFFFFFFFFFFFFFFFFFFFFFFFFF' 

Note:  If Session Point Code Feature is enabled: 
 For all the Query Conditions with Point Code fields the Value Drop Down displays 

"Please Specify other in <flavor> format" where <flavor> is the Session Flavor in 
case of Session Query 

 In case of Network View the Drop Down should display an entry each for the 
distinct possible flavors of all the sessions constituting the Network View. 

 On selecting a Flavor Item, Text Box should display [<flavor>]. User should be 
able to enter the Point Code Value after that. 
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Table 9: Field Types and their Values 

 
 
 

Type 
 

 
 
 
Format 
 

 
 
 
Multiple Values 
 

Wildcards (“?” for 

single character, 

"*" 

(start) for multiple 

characters) 

 
BCD_ADDRESS 

 

 

All hexadecimal 

characters (0-9, A-B) No 

prefix needed 

 

 
 
Yes 

 
Yes, in all places 
 

 
CIC 

 

 

$ as prefix for 

hexadecimal values, 

none as prefix for 

decimal, “-“ for field 

separator depending 

on user preferences, * 

for wildcard 

 

 

 
 
Yes 
 

 

Only * (Only at 

the end) 
 

 

 
DUMP 

 

 

$ as prefix (With or 

without space between 

hexadecimal values) 

(0-9,A-B) 

 

 
Yes 
 

 
No 
 

 
ENUM 

 

 

ENUM Integer *, ? for 

wildcards 

 

 
Yes 
 

 

Yes, in all places 

on label only 
 

 
 
HEXADECIMAL 

 

 

$ as prefix for 

hexadecimal (0-9, A-B) 

values, none as prefix 

for decimal 

 

 
Yes 
 

 
No 
 

 
INTEGER 

 

 
All numbers 
 

 

Yes 

 

No 

 
IP_V4 

 

 
4 numbers (0-255) 

separated by "." 

 

 
Yes 
 

 

No 

 
IP_V6 

 

 
Hexadecimal 
 

 
Yes 
 

 

No 

 
 

MS 
 

 

hhh:mm:ss.ms 

mm:ss.ms ss.ms 
 

ms 
 

 
Yes 

 

No 
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           POINT_CODE 

 

 
Name of a node (text) 

$ for hexadecimal 

values “-“ separator * 
for wildcards 
 

 
As CIC 
 

 
As CIC 
 

 
           STRING 

 

 
All chars 

 
Yes 
 

 
Yes 
 

 
        UNIX_TIME 

 

 
Depending on user 

preferences 
 
 

 
No 
 

 
No 
 

 
 
UNSIGNED 

 

 
 
All numbers 
 

 
 
Yes 
 

 

 
No 
 

 
UNSIGNED3 

 

 
All numbers 
 

 
Yes 
 

 
No 
 

 
VARSTRING 

 
As string 
 
 

 
As string 
 

 
As string 
 

 

 
Note:  For example, all A-numbers greater than 000-000-0000. 

 
7.   Repeat steps 1-6 to create filter conditions for different fields. 
 

8.   Combine the conditions to create a filter condition by using a condition operator such as AND,  
OR, Use Brackets. 

 

Here is an example of a query with multiple conditions. 

 
Figure 31: Query with Multiple Conditions 
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At this point you have two options. You can save the filter for future use or you can apply the filter 

for immediate use. 
 

Note:  Applying a filter does not save it. You must use the save function to keep the filter in the 

system for future use. 

Selecting Displayed Fields for a Query 

 

The Displayed Fields tab provides three options for selecting fields that are displayed in the query. 
 

 All fields - selecting this option incorporates all fields in the dictionary. 

 Common fields - selecting this options enables you to see all common fields if you using multiple 

dictionaries. 

 Custom fields - enables you to select specific fields for the query. This is the default setting. 
 

Selecting the Displayed Fields tab opens the screen. Multiple fields can be selected using the CONTROL 

and SHIFT keys. 

 
Figure 32: Displayed Fields Screen 

Using Split Params Function 
 

The split query function provides a mechanism to split queries executed for a large time duration into 

a sequence of queries of shorter intervals. This option enables you to get query results faster rather 

than waiting to process the whole result set. Each query of shorter duration is executed sequentially 

one after the other as the demand for more results is received. 
 

You execute a query for the time period 10:00:00 A.M to 10:30:00 A.M. If the Split Period is configured 

as 5 minutes, then this query will be split into 7 queries of shorter duration, for example, 10:00:00 - 

10:04:59, 10:05:00 - 10:09:59, 10:10:00 - 10:14:09, 10:15:00 - 10:19:59, 10:20:00 - 10:24:59, 10:25:00 - 10:29:59, 
10:30:00 - 10:30:00 The query between 10:00:00 - 10:05:00 is the first query executed and depending on 

the number of results returned the next query in sequence is initiated. 
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The figure shown here is an example of a split query screen. 
 

 
Figure 33: Split Query Screen 

 
Follow these guidelines to create a split query. 

 

 Choose to split the query - Clicking this option means that the query will be split. You can 

also save the query with this information so that the query is split every time it is 

executed. 

 Select the Hint option - this option provides an indication that is submitted with the query 

and tells the database to perform the split query search in a way that can potentially speed up 

the query. The option not selected by default and should be changed only after consulting a 

certified Tekelec representative. 

 Select a time interval - this option defines intervals the query is divided into. If this option 

is selected, then the query is split into shorter queries with each query's duration equal or 

similar to the Split Period that you define. The Split Period can have any value equal to or 

greater than zero. The value of zero means the query is not split at all. By default, the split 

period is set to 5 minutes and should be changed only after consulting with a certified 

Tekelec representative. 
 

Note:  The choice of Split Period is normally governed by the cardinality of data with respect to  

time. A smaller Split Period will be very effective for data that repeats itself almost every second 

of the time period chosen. 
 

 
 

Recommendations for using split query Function 
 

Query splitting is most effective for the queries on fields having low cardinality. Low cardinality  

means that the fields queried upon have few unique values or are very common. For example, phone 

number fields have high cardinality as they are unique customer identifiers. But fields like  OPC  and 

DPC  have low cardinality because many calls will have same OPC and/or DPC. In general, Query 

Splitting should not be used for queries on phone number fields like A-Number, B-Number and MIN. 

Here are two general recommendations for using split queries. 
 

 Recommendations on using the Split Query option - In order to be sure whether your query runs 
faster with or without Query Splitting you can execute the query with Splitting off and then 
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Re-execute it with splitting on. Based on response time, the query can be saved with the desired 

preference for re-use. This enables you to make the decision once for their subsequent executions. 

  Recommendations on setting the Split Period - The system will initiate the queries in split mode 

until it checks that the page size asked by the user is completely filled. For example, if you have 

set a preference of 300 records per page, the system will keep on executing the split queries until 

it finds 300 or more records. This means that a smaller page size can potentially result into faster 

response to get the first set of data as the system may have to execute less number of split 

queries in sequence to fill the page. 

Saving a Query 

 

You have two choices in saving a query. 
 

 You can click Save and the query is saved for future use. The query is added to the list for that 

o Network View or session. 
 

 Or, if the query already exists, you can click Save as and save the query with another name. 
 

Note: Please refer Appendix C: Queries during Protocol Upgrade for behavior during Protocol 
Upgrade. 

Using Save As Feature 
 

The query dialog screen has a Save As button to enable you to quickly create variations of a query  

without having to go through the full process each time. 

Note: Please refer Appendix C: Queries during Protocol 

UpgradeAppendix C: Queries during Protocol Upgrade 
 

 for behavior during Protocol Upgrade. 

Applying a Query 
 

Complete these steps to apply a filter for immediate use. 
 

1.   Create a query. 
 

2.   After creating the query, click Apply to validate the condition(s) and set the time period. 
 

3.   Specify the time period for the filter in the Time/Date tab in the Query Settings screen. 

Select Predefined and use the pull down to select a predefined time period or select Real Time 

for a real time query. 
 

a)  Select Begin Date and time. 

To select the date and time, you can use the calendar and clock icons beside the fields. 

When using the date icon, clicking on << or >> moves the selected year back or forward. Clicking 

on < or > moves the selected month back or forward. For example, clicking > twice moves the  

date forward two months. 

When using the clock icon, the time interval (hours, minutes, seconds) element changes after  

selecting the previous interval. For example after selecting the hours, the minutes pop-up opens. 
 

b)  Select End Date or time. 

c)   Select whether the time is to be the local time zone or a specific user preference. (The default is 

Use preferences time zone). 
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d)  (Optional) Refresh the First time and Last time information using the Refresh Session Periods 

button to show the date and time of the first and last available data. 
 

Note:  If a query is being made for data that was stored within a period that includes the Daylight 

Savings Time change, you must specify the Begin Time before the time change period. If you specify a 

Begin time that falls within the DST time change period (usually 1 hour), only data that was  

stored after the clock change will be displayed.  
 

4.   Click Execute to run the query or Execute in New to run the query in a new window. 
 

Note:  Up to 5 query windows can be open at one time. 
 

Using a parameter to initiate multiple Queries 
 

ProTrace enables you to create a parameterized query. When the query is executed ProTrace prompts 

you for the parameter. For one parameter it displays one prompt which is then filled into one condition 

( for example an A-number). This feature enables you to use one prompt for several conditions. For 

example, to create a query with a single prompt “A-B-C Number:” which would be used for A-number, 

B-number, and C-number. 
 

1.   Click the Create button on the Query list page. 

The Query Dialog is displayed. 
 

2.   Add a dictionary. 
 

3.   Add several conditions (for example A-number, B-number, and C-number). 
 

Define the values so that these conditions are parameterized. The value must be in the following 

format: #{<prompt text>} 
 

   You can mix parameterized and non-parameterized conditions in the same query. 

 

Note:  To share the prompt, the prompt text has to be the same for all shared parameters. 

 

Note:  It is not possible to share prompts for Enumeration fields. 
 

 
Figure 34: One Parameter for Multiple Queries 
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Note:  It is not possible to share prompts for Enumeration fields. 

 
4.   Save the query. 

Note:  When a parameterized query is executed, the Query Settings dialog contains an additional 

Parameters tab with the new parameters. 
 

Note: Please refer Appendix C: Queries during Protocol Upgrade for behavior during Protocol 
Upgrade. 

 
 

Using Pre-defined Time Intervals for Real-time Traces 

You can use pre-defined time intervals in your queries when initiating real-time traces. 

Complete these steps when utilizing this option. 

 
1.   Create new query or select a query from query list. 

 

2.   Click the Execute button. 
 

The Query Settings screen opens. 

 
3.   Select RealTime. 

 

The screen options change. 
 

Note:  When you select Real Time the Predefined option is automatically selected and the date and 

time fields are grayed out. 
 

4.   Select a time interval (the options range from the next 5 minutes all the way to until canceled). 
 

5.   Click Apply to initiate the trace. 
 

 

Using Save As Feature 
 

The query dialog screen has a Save As button to enable you to quickly create variations of a query  

without having to go through the full process each time. 
 

 

Testing a Query Using the Plan Function 
 

Clicking the plan button on the bottom of the Options tab (or in the xDR viewer menu bar) enables 

you to initiate the plan function. When the test is completed, the screen opens to show the results. 
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Figure 35: Plan function screen - test completed 

 

The screen shows all the planned steps for completing the query. 

When finished, click Close to close the screen. 

Using Flex Matching in Queries 
 

With flex matching filters, you can also use the ~= operator between fields. This operator allows you 

to filter on a subset of address digits and eliminates the need for an early determination on whether 

the address digits include an area code, country code or trailing characters. 
 

The following rules apply to flex matching filters: 
 

 The minimum length of the match must be more than half the length of the longer number. 

For example, if the target is a thirteen digit number, a number which matches it will have to 

be at least seven digits long. A filter match for 4119194605500 will match 4605500, but will not 

match 605500, because 605500 is not longer than half of the filter target. 

 The minimum length of the match must also be at least five digits in length. For example, 

A filter match for 4605500 will not match 5500 because it is not at least five digits. 

   Flexible Matching is available for all filters and traces (whether predefined or not) when 

address digits are involved unless overridden by Wildcard Matching. 

 
Note:  The field (EPI) will be queried by flex matching if the "Flex Matching" function is 
enabled and if a given EPI is enabled for flex matching. (See EPI Configuration 
 
) 

 

Note:  Enabling of flex matching function has a strong impact on performance. 
 

Using the Multiprotocol Function 
 

You can run your query using multiple protocols when you select the multiprotocol function in the 

Options tab. In Multi-Protocol tracing other protocols may be examined to find other legs or transactions 

of the trace. 

 

Complete this step when using multiprotocol option. 
 

1.   Select Options tab. 
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2.   Select Use Multiprotocol shown here. 

 
Figure 36: Options Tab with Multiprotocol Selected 

 

 
3.   Click Execute to run the query. 

The query is initiated and a status bar appears that shows the progress of the query. 
 

Note:  You can cancel the query by clicking Cancel under the progress bar. Only those records that 

have been completed up to the time of cancelling will appear. 
 

The xDR viewer is displayed with the filter criteria and xDRs for each of the filtered protocols. The 

filtered protocols appear at the bottom table. In the case of real-time queries, all results are updated 

every five seconds by default. 
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Figure 37: Trace View Screen 

You can save the filter for future use. The filter will be added to the list for that Network view. 

 

Note:  The directionality of a call is in context of whether it is node-centric or eagle-centric. 

 
 
 

PDU Delete Prompt 
 

If there have been some configuration changes that result in PDUs being deleted from the system, a 

screen prompt appears when the trace is completed. The figure shown here shows a completed trace 

with the prompt located at the bottom of the screen. 

 
Figure 38: Deleted PDU Prompt 

 

 
How to Display Time Difference for PDUs 

 

This function enables you to display the time difference between two PDUs. Complete these steps to 

display the PDU time difference. 
 

1.   Select a PDU. 
 

2.   Move the cursor over another PDU. 
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3.   ProTrace shows a time difference in the PDU view toolbar in form of HH:MM:SS.sss (HH – hours, 
MM – minutes, SS – seconds, sss – milliseconds). 

 

The figure below shows a PDU difference. 

 
Figure 39: Time Difference between PDUs 

Modifying a Filter 

 

Complete these steps to modify an existing filter. 
 

1.   In the initial page, select a Network view or Session from the query list (left section). 
 

2.   Select a Filter from the list. 
 

In this example the filter selected is Answered. 

 
Figure 40 : Selected Filter 

 

 
3.   Click Modify button on the toolbar. 

 

The Query Dialog opens with the existing filter shown in Figure41: Filter Opened For Modification. 
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Figure41: Filter Opened For Modification 

4.   Make the necessary modifications. 
 

In this example a Description is added. 

 
 
 
 
 

 
Figure 42: Filter Modification - Description Added 
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5.   Click Save. 
 
The filter is validated and changes are saved. 

 

Note:  If there is an error in the validation, you are shown the error. 

 

Note:  If you want to save the modifications as a new query use the Save As option. 

 

Note: Please refer Appendix C: Queries during Protocol Upgrade for behavior during Protocol 
Upgrade. 
 

Deleting a Filter 

Follow these steps to delete an existing filter. 
 

1.   Select the Filter to be deleted. 
 

2.   Click Delete. 

3.   Click OK at the prompt. 

The filter is deleted. 
 

Multi-link Filter and Traces 
 

You can use the multi-link filter trace feature to filter/trace several links or linksets at once. Complete 

these steps to use this feature. 
 

1.   Select a link-based network in the network tree. 

(Left-hand section of initial page.) 
 

2.   Click Multi-link. 
 
 
 

The multi-selection screen opens. 
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Figure 43: Multi Selection Screen 

 
 

 
3.   Select the linksets or links to be included in the trace. 

 

Note:  Click the Check box to select all the linksets/links in the list or click the empty box to select 

none of the linksets/links. 
 

4.   Click Apply. 
 

               The selection is used in the query and tracing. 

 

Note:  Multi-link selections cannot be saved. 
 

Note:  The multi-link selection is cancelled by selecting another link-based or session-based network 

view. 

xDR Viewer 

 
You can view specific xDRs using the xDR Viewer. Using the xDR Viewer you can choose a specific 

xDR in order to initiate a trace. This view is used for both Filtering and In Progress Traces. The xDR  

Viewer can display three different views: 
 

 xDR display 

 PDU display 
 

 Decoding display 
 
 



 

 78 

Using xDR Viewer 
 

The XDR Viewer in ProTrace enables you to choose a desired xDR in order to view the corresponding 

PDUs (as a list and individual decode) and to initiate the trace. Complete these steps to launch a trace 

using an xDR. 
 

Note:  The Start Trace feature is may not be available depending on your product license and 

installation. PDUs and decode are only available to the Business Manager role. 
 

1.   Create or select an existing Query for a network view. 
 

See Filtering Modes and Managing Queries 

             for more information. 
 

2.   Execute the Query. 
 

The xDR viewer page opens. 

 
Figure 44: XDR Viewer Page 

 
 

 
3.   Select an xDR record (in this example the first record is selected). 

 

4.   Click Start Trace. 
 

The trace viewer page opens showing Trace records, calls per trace and de-coded traces. 
 

Note:  The PDUs appear in two different colors. The pink PDUs belong to the currently selected 

xDR. The PDUs that belong to unselected xDRs appear with a white background. 

 

Note:  You can open up to five traces from the xDR Viewer screen. 
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Figure 45: Trace Viewer Page 

 
 

 
5.   You can now export the xDR’s and PDU’s. 

 

 

Using Drill Down with Statistical Sessions 
 

When viewing Statistical sessions (from ProTraq), you can use the drill down feature to view the list 

of xDRs that were used to calculate the KPI along with the associated protocol decoding. 
 

To do this: 
 

1.   Right click on a session in the sessions list. 
 

Two buttons will appear next to the selection, Drill Down and Add Condition. 
 

2.   Click on the Drill Down button. 
 

The xDR information is displayed. If the sessions are also sessions generated using ProTraq, you 

can drill down further. 
 

Note:  This feature is only available when viewing statistical sessions from ProTraq and it must be 

configured in ProTraq. See the ProTraq User Guide for more information. 
 
 

xDR Finder Option 
 

ProTrace comes with an xDR search feature. Clicking the xDR Finder icon (next to the Export icon) on 

the xDR viewer page opens the xDR Finder screen. There are several options to limit the search reaults 

that you can select before initiating an xDR search. 
 

 
Possible Search Parameters 

 
 The Text field is for the xDR name or other text. 

 Limit the search by selecting Case Sensitive. 
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 Limit the search to a specific xDR by selecting Search within XDRs. 
 

 Limit the search by selecting Search within Frames. 

 Limit the search by selecting Search within Full Decoding. 

 Limit the search by selecting Search within Frame Bytes. 

 The Record Limit field allows you to limit the search to the first n records where n is a 
number. 

 
 

Search Results 
 

The xDR search results are presented in a table format. You can page through the results with the page 

arrows and you can set the number of records per page in the Set Size (check icon) text box. 

 

Table 10: xDR Search Results Columns 

 
Column 

 

 
Description 
 

 
xDR Number 

 

 

The xDR number 

 
SU Number 

 

 
The frame number for this xDR. 
 

 
            Decoding Number 
 

 

The line number in full decoding 

 

             Found Text 

The complete line where the string was found. It 

can be an xDR, a frame, a line in full decoding, 

or the complete hexadecimal. The searched 

string is highlighted. 

 

 

Copying xDR information 
 

When viewing xDRs you can copy the information for the currently selected xDR, it's PDUs, and full 

decodes as text information. To do this click the Copy button on the xDR viewer toolbar. The information 

will be available in the system clipboard. 
 

Note:  This feature is only available when viewing statistical sessions from ProTraq and it must be 

configured in ProTraq. See the ProTraq User Guide for more information. 

Exporting Results 

You can export any list of sessions, list of queries, or xDR results by using the Export facility of ProTrace. 

You can export to the following file formats: 
 

•   XML 

•   XLS 

•   CSV 

•   HTML 

•   TXT 

•   PCAP 
 
Note:  You can only export SUs in case of PCAP. 
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You will also be able to export SU and Full Decoding and to ZIP when exporting xDR results. 
 

You can also export xDR information directly to Excel format using the Direct Excel Export button in 

the xDR list window. 
 

Note:  Direct to Excel export will export all xDR information except the number of PDUs and the 

decode information. 
 

 

System Export Limits 
 

The table shows the system export limits for each format. 

 
 

Table 11: System Export Format Limits 

 
Format 

 

 
Max. # of xDRs for Interactive Exports 
 

 
ZIP 

 

 
100,000 

       
            TXT 
 

 
10,000 

 
            XML 
 

 
1,000 

 
HTML 

 

 
1,000 

 
              CSV 

 
650,000 
 

 
             XLS 

 
65535 
 

 
             PCAP 

 
100,000 

 
Note: The export will be limited to a maximum of 10,000 PDUs or 100,000 xDRs (xDRs matching the 
export criteria). Once one of these limits gets reached, PCAP export will stop and store the exported file as 
it is. 
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Exporting 

To open the Export screen, click the Export icon in the sessions list or query list toolbars for to export 

sessions or query lists. Use the Export icon in the toolbar of the query results window to export results. 
  

 

Exporting Files 
 

Complete these steps to export a file. 
 

1.   Select the data to be exported.  

You can choose: 

a)  Current page 

b) All results 

c)   First records  
 

Note:  If you select First records type in a number for the number of records that will be exported. For 

example, entering the number 100 designates that only the first 100 records are to be exported. 

 
2.   Type in the file name in the Enter a filename field. 

3.   (Optional) you can select whether to have the title inserted at the beginning of the exported file by 

selecting the option by the Enter a title field. 
 

4.   (Optional) you can type a comment or description in the Comment field. 
 

Note:  The file is saved in the same extension type as in the list. 
 

5.   Select the format type in the Export Type section. You can choose: 

a) XML 

b)   XLS  

c)    CSV 

d)   HTML 

e)   TXT 
f)     ZIP 
g)    PCAP 
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Note: 
 

 PCAP is only available for users with NSP Business Manager  role. 
 ZIP is only available for users with NSP Business Power User role. 
  ZIP is not available for the current page option. 
  ZIP is available for single dictionary queries only. 
 PCAP is available to export all the Sigtran PDUs of a given trace (current page, all results 

of the query or the first n( xDRs)  into a Wireshark compatible PCAP file. 
  On selecting PCAP option “with SU” and “ Full decoding” options will be grayed out and “ 

with SU” option will be checked by default 
 The SU and Full Decoding options are only available for users with NSP business Manager 

Role. 
  The Stored in the NSP database option is only available for users with NSP Business 

Power User role. 
6.   Select what to do with the exported data. Download now (default) or Stored in the NSP database. 

 

7.   Click Export to export the file. 
 

Note:  If the export will take longer than the current allotted time for exports (currently 30 minutes) 

it will automatically be canceled and you will receive a error message. This can happen when the 

query is too large or the IXP is overloaded. You can resolve this by running the export at a later 

time or using the Split Query option. 
 
 

Figure 46: Export Type 
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Chapter 5: Analyzing Traces 

 
 

 

 
 

 Overview 

 Analyzing Traces 
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Overview 

 
ProTrace provides the ability to analyze the trace results returned by historical and in-progress traces. 

You can choose to view the trace in historical mode or real time mode. You are able to view the incoming 

trace messages for both real-time and historical trace. For real-time trace the application checks for 

new messages every 5 seconds (by default) starting from the current time. 

 

Note:  Tracing is supported for Network views only. It is not available for single sessions or 

archives. 

 

Analyzing Traces 

 
You can view the trace results returned sorted by time-stamp. You can initiate 5 different traces, thus 

troubleshooting more than one problem at the same time. For enhanced troubleshooting you are 

provided with all PDUs for a selected record from the summary and detailed protocol decoding for  

the selected PDU. You can also export the trace results in html and binary formats for offline 

troubleshooting. You can then import them back into ProTrace using the Import option. 
 

Note:  When viewing xDRs, PDUs and PDU decodes some sensitive information may be hidden using 

the "*" character (except for the Business Manager user). This hiding may be present for some PDUs 

but not for others depending on the configuration parameters. This functionality is configured in the 

CCM. See the Centralized Configuration Manager Administration Guide for more information. 
 
 

Viewing Real-time Traces 

 

Complete this step to view a real-time trace. 
 

Launch a trace. The records are displayed and the Trace Summary page opens where you can see the 

summary of all the traces displayed in chronological order in real time. From the summary page you 

can view the following elements and perform the following actions: 
 

 In the PDU display you can view the PDUs returned by the trace. Even those PDUs that 

may not be related to an xDR/TDR but are retrieved from the related interface. 

  Level 4 messages (Circuit Blocking, Reset) can be viewed as part of a normal call-

related trace, in order to correlate events occurring during a call, or shown separately.  

  The PDU decoding section is displayed where you can view the Decoding for each trace 

PDU. 

 You can browse through the Trace PDUs and the decoding section automatically displays 

the decoding for the currently selected PDU. 

  New trace messages are scanned every 5 seconds from current time and displays them 

to you. You are able to view new PDUs arriving while browsing the already displayed 

PDUs. 

  The trace stops when the time period configured expires. 

Viewing Historical Traces 

Complete this step to view historical traces.  
Launch a trace. The records are displayed and the Trace Summary page opens where you can see the 

summary of all the traces displayed in chronological order in begin time. From the Summary page 

you can view the following elements and perform the following functions. 
 

  In the PDU display you can view the PDUs returned by the trace. Even those PDUs that 

may not be related to an xDR/TDR but are retrieved from the related interface. 
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  Non-call messages are displayed (e.g. Circuit blocking, Reset). 

  The PDU decoding section is displayed where you can view the Decoding for each trace 

PDU. 

  You can browse through the Trace PDUs and the decoding section automatically 

displays the decoding for the currently selected PDU. New trace messages are scanned 

and displayed. 

Managing Protocol Filters 
 

You can select displayed protocols for executed traces. Complete these steps to select protocols for a 

trace. 
 

1.   Select the xDR to be traced. 
 

2.   Click Start Trace to begin new trace. 

3.   Click Display filter on the toolbar. 

The Protocol Filter Dialog opens. 

 
Figure 47: Filter Selection Dialog 

 
 

4.   Select or de-select the desired Protocols. 
 

Note:  To select ALL protocols check the left-hand check box located at the top of the dialog. To 

de-select ALL protocols click the right-hand check box located at the top of the dialog. 
 

5.   Click Apply to display the trace with the selected protocols. 
 
 
 

Viewing a Message Sequence 
 

ProTrace enables you to view the sequence of messages in the graphical format for the 

selected trace. Each node is represented in the form of a vertical line in the diagram. If a 
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node has multiple IP Addresses or Point Codes, there are two options of sequencing: 
 

 If there is no access to a database giving the list of IP Addresses or Point Codes 

per Node, ProTrace uses one vertical line per IP Address or Point Code, that can 

make the diagram difficult to read 

 If there is an access to a database with the list of IP Addresses or Point Codes for 

each node represented by a Label, ProTrace uses one vertical line per Node 

(using the Label), and the IP Addresses or Point Codes appear in the messages 

arrows between the nodes. 

 

 The Message Sequence Diagram (MSD) feature is developed for real-time as well 

as historical traces. It can be used for PDUs. There are some useful features to 

the MSD layout. 

 

  Graphic layout for easy viewing - can view details of PDU in graphic instead of 

tabular format 

   Associated decode and background views - select a PDU and the associated 

background information and decode information is shown. 

   Time difference indicator - cursor over a selected PDU and time difference is 

shown 
 

 
Figure 48: MSD Layout Screen 

 
These features include: 

 

Viewing MSDs 

You have the option to toggle between the display of MSDs and PDUs. 
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Complete these steps to view the message sequence. 

 
1.   Select the xDR or PDU you want to view. 

 
Figure 49:xDR Viewer with xDR And PDU Selected 

 

 
2.Click the Execute button . 

 

The page layout changes to show the view sequence. 
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Figure 50:Message Sequence View 

Viewing Real-time Message Sequences 

 
Complete these steps to view real-time message sequences. 
 
1.   Click Message Sequence Diagram to initiate the display. 
 
The application responds by displaying all the messages as a message sequence diagram.  
 
2.   You can then browse through the diagram displaying the trace. 
 

 

Viewing Historical Message Sequences 
 

Complete these steps to view historical message sequences. 
 
1.   Click Message Sequence Diagram to initiate the display. 
ProTrace displays all the messages as a Message sequence diagram. 
 
2.   You can browse through the diagram displaying the trace. 
 

 

About Exporting Traces 
 

ProTrace enables you to export the trace. You can export the trace in either html or binary format. See 

Error! Reference source not found. for more information. 
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Exporting a Trace File 
 

Once you have created a filter, run the filter query, selected a record to trace, the Trace Viewer screen 

opens. Complete these steps to export trace files. 
 

1.   Click Export to initiate the export of trace results. 

You are prompted to either Save (export) or Open the file. 

a)  Click Export to create a zip file with Binary format. 

b)  Click Export HTML to create a zip file with HTML format. 
 

Note:  You have two buttons on the Trace viewer page. Export and Export HTML. Click the 

button appropriate to your needs. 
 

Note:  When you export a Binary or HTML file, the a progress bar appears showing the progress 

of the export and the time remaining for the export to finish. 
 

 
Figure 51:Export Progress Bar 

 

Note:  To cancel the export, click the red “X” located on the right-hand side of the export bar. 

A prompt opens stating that the export process has been canceled. 
 

 

 
Figure 52: Export Screen 

 
2.   To export the file, click Save. 
The PDUs are exported in the desired file format and stores it at the path you specified. 

 
3.   To open the file, click Open and your Zip application opens. 
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Figure 52: WinZip File Screen 

 

 

Importing a Trace File 
 

You can import a trace file that has been exported to a directory by using the Import function. Complete 

these steps to import a trace file. 

1.   Select File > Import Trace. 

The import screen opens. 
 

2.   Browse for the file you want. 
 

3.   Click Import. 

The file is imported and shows up on the Trace viewer page. 
 

Note: User will be allowed to browse only those files which were initially exported in ZIP 

format after they are subsequently imported. 
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Appendix A: Level 2_3 Traces 
 

 

 

 
 

 About Level 2/3 Traces 

 Tracing Level 2 and Level 3 Messages 
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About Level 2/3 Traces 

 
ProTrace gives you the ability to perform a trace to identify non-call related issues. It can trace various 

MTP3 (Network Management) and MTP2 (SS7 LSL, SS7 Sigtran) messages. 
 

Note:  You must have the L2/L3 protocol builder installed in order trace non-call related issues. 

Tracing Level 2 and Level 3 Messages 

 
Complete these steps to trace level 2 or level 3 messages. 

 
1.   Select View >Non-call related menu option. 

 

2.   Select the Session or Link-based view that will need the query. 
 

3.   Select or create a filter. 
 

4.   Analyze the results in the xDR viewer. 
 

 

Note:  In XDR viewer the trace icon will be disabled for this level of call. 
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Appendix B: Master Data Information 
 

 

 
 
 

 About Master Data Information 

 Supported Protocols 
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About Master Data Information 

 
ProTrace gives you the ability to perform a trace to identify non-call related issues. It can trace various 

MTP3 (Network Management) and MTP2 (SS7 LSL, SS7 Sigtran) messages. 
 

Note:  You must have the L2/L3 protocol builder installed in order trace non-call related issues. 

This appendix provides information on the supported protocols and protocol combinations for  

In-Progress calls. 

Supported Protocols 

 
This table shows the list of supported protocols used by ProTrace. 
 

Table 12: Supported Protocols 

 
Protocol A 

 

  
Protocol B 
 

          
AIN 

 
 

 
       <-> 
 

 
BICC ANSI 
 

 
AIN 

 
 

 
       <-> 
 

 
ISUP ANSI 
 

 
 AIN 

 

 
       <-> 
 
 

 
TUP 
 

 
    BICC ANSI 
 

 
       <-> 
 
 

 
AIN 
 

 
   BICC ANSI 
 

        
        <-> 
 

 
BICC ANSI 
 

 
    BICC ANSI 
 

        
        <-> 
 

 
CLASS 
 

 
   BICC ANSI 
 

        
        <-> 
 

 
INAP 
 

   
   BICC ANSI 
 

 
       <-> 

 
IS41 ANSI 
 

 
   BICC ANSI 
 
 

 
      <-> 

 
LIDB 
 

    
  BICC ANSI 
 

 
     <-> 

 
MAP ETSI 
 

 
BICC ETSI 

 

      
      <-> 

 
BICC ETSI 
 

 
BICC ETSI 

 

           
       <-> 

 
 
BSSAP 
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BICC ETSI 
 

<->  
INAP 
 

 
BICC ETSI 
 

 
<-> 

 
IS41 ANSI 
 

 
BICC ETSI 
 

 
<-> 

 
LIDB 

 
BICC ETSI 
 

 
<-> 

 
MAP ETSI 
 

 
BSSAP 
 

 
<-> 

 
BICC ETSI 
 

 
BSSAP 
 

 
<-> 

 
BSSAP 
 

 
BSSAP 
 

 
<-> 

 
ISUP ANSI 

 
BSSAP 
 

 
<-> 

 
ISUP ETSI 
 

 
BSSAP 
 

 
<-> 

 
MAP ETSI 
 

 
CLASS 
 
 

 
<-> 

 
BICC ANSI 

 
CLASS 
 
 

 
<-> 

 
CLASS 

 
CLASS 
 

 
<-> 

 
ISUP ANSI 
 

 
Gprs Gb 
 

 
<-> 

 
Gprs Gb 
 

 
Gprs Gb 
 
 

 
<-> 

 
Gprs Gn 
 

 
Gprs Gb 
 
 

 
<-> 

 
GSM MAP 
 

 
Gprs Gb 
 

 
<-> 

 
IPMultimedia 
 

 
Gprs Gb 
 

 
<-> 

 
IPRadius 
 

 
Gprs Gn 
 

 
<-> 

 
Gprs Gb 
 

 
Gprs Gn 
 

 
<-> 

 
Gprs Gn 
 

 
Gprs Gn 

 
<-> 

 
GSM MAP 
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Gprs Gn 
 

 
<-> 

 
IPMultimedia 
 

 
Gprs Gn 
 
 

 
<-> 

 
IPRadius 
 

 
INAP 
 

 
<-> 
 

 
BICC ANSI 
 

 
INAP 
 
 

 
<-> 
 

 
BICC ETSI 
 

 
INAP 
 
 

 
<-> 
 

 
INAP 
 

 
INAP 
 
 

 
<-> 
 

 
ISUP ETSI 
 

 
INAP 
 

 
<-> 
 

 
MAP ETSI 
 

 
IP Multimedia 
 

 
<-> 
 

 
Gprs Gb 
 

 
IP Multimedia 
 

 
<-> 
 

 
Gprs Gn 
 

 
IP Multimedia 
 

 
<-> 
 

 
IPMultimedia 
 

 
IP Multimedia 
 
 

 
<-> 
 

 
IPRadius 
 

 
IP Radius 
 

 
<-> 
 

 
Gprs Gb 
 

 
IP Radius 
 

 
<-> 
 

 
Gprs Gn 
 

 
IP Radius 
 

 
<-> 
 

 
IPMultimedia 
 

 
IP Radius 
 

 
<-> 
 

 
IPRadius 
 

 
IS41 
 

 
<-> 
 

 
MAP ETSI 
 

 
IS41 ANSI 
 

 
<-> 
 

 
BICC ANSI 
 

 
IS41 ANSI 
 

 
<-> 
 

 
BICC ETSI 
 

 
IS41 ANSI 
 

 
<-> 
 

 
IS41 ANSI 
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IS41 ANSI 
 

<-> 
 

IS41 SERVICES 
 

 
IS41 ANSI 
 

 
<-> 
 

 
ISUP ANSI 
 

 
IS41 ANSI 
 

 
<-> 
 

 
ISUP ETSI 
 

 
IS41 SERVICES 
 

 
<-> 
 

 
IS41 ANSI 
 

 
IS41 SERVICES 
 

 
<-> 
 

 
IS41 SERVICES 
 

 
IS41 SERVICES 
 

 
<-> 
 

 
ISUP ANSI 
 

 
IS41 SERVICES 
 

 
<-> 
 

 
ISUP ETSI 
 

 
IS41 WIN services 
ANumber 

 

 
<-> 
 

 
GSM MAP MSISDN 
 

 
IS41 WIN services 
BNumber 

 

 
<-> 
 

 
GSM MAP BMSISDN 
 

 
IS41 WIN services 
CNumber 

 

 
<-> 
 

 
GSM MAP CMSISDN 
 

 
IS41 WIN services 
MIN/IMSI 

 

 
<-> 
 

 
GSM MAP IMSI 
 

 
IS41 WIN services 
CgSccpAdd 
 

 
<-> 
 

 
GSM MAP CgSccpAdd 
 

 
IS41 WIN services 
CdSccpAdd 
 

 
<-> 
 

 
GSM MAP CdSccpAdd 
 
 

 
IS41 WIN services MDN 
 

 
<-> 
 

 
GSM MAP MSISDN 
 

 
IS41 WIN services TLDN 
 

 
<-> 
 

 
GSM MAP CMSISDN 
 

 
ISUP ANSI 

 

 
<-> 
 

 
AIN 
 

 
ISUP ANSI 
 

 
<-> 
 

 
BSSAP 
 

 
ISUP ANSI 
 

 
<-> 
 

 
CLASS 
 

 
ISUP ANSI 
 

 
<-> 
 
 

 
INAP 
 
 
 



 

 99 

 
 

 
ISUP ANSI 
 

 
<-> 
 

 
IS41 ANSI 
 

 
ISUP ANSI 
 

 
<-> 
 

 
IS41 SERVICES 
 

 
ISUP ANSI 
 

 
 
<-> 
 
 

 
ISUP ANSI 
 

 
ISUP ANSI 
 

 
<-> 
 

 
ISUP ETSI 
 

 
ISUP ANSI 
 

 
<-> 
 

 
LIDB 
 

 
ISUP ANSI 
 

 
<-> 
 

 
MAP ETSI 
 

 
ISUP ANSI 
 

 
<-> 
 

 
MAP SMS 
 

 
ISUP ANSI 
 

 
<-> 
 

 
VOIP MGCP 
 

 
ISUP ANSI 
 

 
<-> 
 

 
VOIP SIP 
 

 
ISUP ANSI 
 

 
<-> 

 
VOIP SIPT 
 

 
ISUP ANSI 
 

 
<-> 

 
MGCP CDR 
 

 
ISUP ANSI 
 

 
<-> 

 
VOIP Q931 
 

 
ISUP ETSI 
 

 
<-> 

 
BSSAP 
 

 
ISUP ETSI 
 
 

 
<-> 

 
INAP 
 

 
ISUP ETSI 
 

 
<-> 
 

 
IS41 ANSI 
 

 
ISUP ETSI 
 

 
<-> 
 

 
IS41 SERVICES 
 

 
ISUP ETSI 
 

 
<-> 
 

 
ISUP ANSI 
 

 
ISUP ETSI 
 

 
<-> 
 

 
ISUP ETSI 
 

 
ISUP ETSI 
 

 
<-> 
 

 
MAP ETSI 
 

 
ISUP ETSI 

 
<-> 

 
MAP SMS 
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ISUP ETSI 
 

 
<-> 
 

 
VOIP MGCP 
 

 
ISUP ETSI 
 

 
<-> 
 

 
VOIP SIP 
 

 
ISUP ETSI 
 

 
<-> 
 

 
VOIP SIPT 
 

 
ISUP ETSI 
 

 
<-> 
 

 
VOIP Q931 
 
 

 
LIDB 
 

 
<-> 
 

 
BICC ANSI 
 

 
LIDB 
 

 
<-> 
 

 
BICC ETSI 
 

 
LIDB 
 

 
<-> 
 

 
ISUP ANSI 
 

 
LIDB 
 

 
<-> 
 

 
LIDB 
 

 
LIDB 
 

 
<-> 
 

 
TUP 

 
MAP ETSI 
 

 
<-> 
 

 
BICC ANSI 
 

 
MAP ETSI 
 

 
<-> 
 

 
BICC ETSI 
 

 
MAP ETSI 
 

 
<-> 
 

 
BSSAP 
 

 
MAP ETSI 
 

 
<-> 
 

 
INAP 
 

 
MAP ETSI 
 

 
<-> 
 

 
ISUP ANSI 
 

 
MAP ETSI 
 

 
<-> 
 

 
ISUP ETSI 
 

 
MAP ETSI 
 

 
<-> 
 

 
MAP ETSI 
 

 
MAP ETSI 
 

 
<-> 
 

 
MAP SMS 
 

 
MAP SMS 
 

 
<-> 
 

 
ISUP ANSI 
 

 
MAP SMS 
 

 
<-> 
 

 
ISUP ETSI 
 

 
TUP 
 

 
<-> 
 

 
AIN 
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TUP 
 

 
<-> 
 
 

 
LIDB 
 

 
TUP 
 

 
<-> 
 

 
TUP 
 

 
VOIP MGCP 
 

 
<-> 
 

 
ISUP ANSI 

 
VOIP MGCP 
 

 
<-> 
 

 
ISUP ETSI 
 

 
VOIP Q931 
 

 
<-> 
 

 
ISUP ANSI 
 

 
VOIP Q931 
 

 
<-> 
 

 
ISUP ETSI 
 

 
VOIP SIP 

 
<-> 
 

 
ISUP ANSI 
 

 
VOIP SIP 

 
<-> 
 

 
ISUP ETSI 
 

 
VOIP SIP 

 
<-> 
 

 
VOIP SIP 
 

 
VOIP SIPT 
 

 
<-> 
 

 
ISUP ANSI 
 

 
VOIP SIPT 
 

 
<-> 
 

 
ISUP ETSI 
 

 
VOIP SIPT 
 

 
<-> 
 

 
VOIP SIPT 
 

 
VoipH245 
 

 
<-> 
 

 
VoipQ931 
 

 
VoipH248 
 

 
<-> 
 

 
VoipQ931 
 

 
VoipQ931 
 

 
<-> 
 

 
VoipH245 
 

 
VoipQ931 
 

 
<-> 
 

 
VoipH248 
 

 
VoipQ931 
 

 
<-> 
 

 
VoipQ931 

 
 
VoipQ931 
 

 
<-> 
 

 
VoipRas 

 
 
VoipRas 
 

 
<-> 
 

 
VoipQ931 
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Appendix C: Queries during Protocol Upgrade 
 

During Protocol Upgrade, if all the sessions based on a dictionary are not upgraded then the dictionary is 

considered as not completely upgraded. In this intermediate state there are some limitations on creation and 

modification of query as described below. 

Creating a Query 

While creating a query if user selects a dictionary, which has been replaced (upgraded) by dictionary of 

different version then the creation of query is not allowed. An error is displayed to user mentioning that                                   

“The dictionary:<DICTIONARY_NAME> has been upgraded. Query creation using old dictionary is not 

allowed.” 

Modifying a Query 

While modifying a query if user selects a dictionary which is not completely upgraded then an error message 

is displayed to user mentioning "All Sessions are not upgraded for this dictionary. Please upgrade all 

sessions and then try again.” 

Also in case if user selects a dictionary which has been replaced (upgraded) by dictionary of different version 

then an error message is displayed to user mentioning "This dictionary(s) has been upgraded. Query 

modification using old dictionary is not allowed.” 

 
 


